<|ll

Web-enable a 5250 application using the
IBM WebFacing lool



ii  Web-enable a 5250 application using the IBM WebFacing Tool



Contents

Web-enable a 5250 application using the

IBM WebFacing Tool .1
Introduction . .1
Reviewing the 5250 order entry apphcatlon . .3
Starting the 5250 application . . .4
Accessing the online help . .4
Selecting a customer . .6
Filling the order . .8
Completing the order .9
Module summary . 10
Creating the WebFacing pro]ect . 10
Starting the product . . . 10
Opening the WebFacing perspectrve . 12
Starting the WebFacing Web Project wizard. .14
Selecting a Web style . . .15
Selecting source members to convert .17
Specifying the CL command to launch the
application .22
Completing the WebFac1ng pro]ect 1nf0rrnat10n 23
Module summary . . 26
Converting selected source members .27
Selecting the project and source members .27
Starting the WebFacing conversion .28
Checking the conversion logs . 30
Module summary . . 30
Running the WebFacing apphcatlon . . 31
Showing the index.jsp page . .32
Testing the WebFacing application . . 34
Testing the help support . . 37
Module summary . 37
Changing the user interface usmg Web Settlngs and
Screen Designer . . . 38
Opening DDS display f11e source in Screen
Designer o . 39
Applying Web Settlngs . 40
Testing the changed apphcatlon . 46
Module summary .47
Changing the user interface us1ng Web Settlngs in
the LPEX Editor . . 47
Opening DDS display frle source in the LPEX
Editor . . 48
Applying Web Settlngs in the LPEX Edltor . 49
Testing the changed apphcatlon . . 55
Module summary . 57
Changing the style of the Web user 1nterface . 57
Changing the rules for highlighted fields . 58

Changing styles directly .
Testing the changed application
Module summary .
Adding command key rules and labels .
Adding a new command key description pattern
Adding key button labels.
Module summary
Working with more style propertles .
Starting the WebFacing properties style d1alog
Changing the appearance of the subfile .
Customizing the appearance of command keys
Checking the new style
Module summary
Customizing the default style
Opening Pagebuilder.jsp .
Importing the company logo
Editing the style sheet and PageBullder]sp
Module summary .
Adding authentication. .
Removing the default user ID and password .
Testing the authentication dialog
Module summary
Enhancing index.jsp page.
Opening Page Designer .
Working with page properties .
Linking a cascading style sheet to a Web page
Adding a heading 1 tag to the page .
Adding a picture to the page
Adding moving text to the page
Changing the text color . .
Deleting default text from the page .
Module summary .
Exporting to i5/0S WebSphere Apphcatlon Server
(Optional) .
Exporting your EAR f1le
Installing the application .
Testing the deployed WebFacing appllcatlon .
Module summary . .
Mixing a WebFacing and non—WebFacmg
application .
Adding another CL Command to launch another
application . .
Testing the non—WebFacmg apphcat1on
Module summary . .
Summary .

. 61
. 64
. 65
. 66

67

. 70
.72
.73
.73
.75

77

. 78
.78
.79
. 80
. 81
. 82
. 85
. 86
. 86
. 88
. 89
. 89
.90
.91
. 93
. 94
. 95
.97

. 100

. 101

. 103

. 104
. 104
. 107
112
. 112

. 113

. 113
. 116
. 118
. 119

iii



iV Web-enable a 5250 application using the IBM WebFacing Tool



Web-enable a 5250 application using the IBM WebFacing Tool

This tutorial teaches you how to use the IBM® WebFacing Tool to Web-enable a 5250 application. You
learn about customizing the output of the conversion process using the IBM WebFacing Tool and the
LPEX Editor and you learn how to run the WebFacing application in the WebSphere® Test Environment
that is part of the product. You also learn about deploying the application to the WebSphere Application
Server and mixing a WebFacing application with a non-WebFacing application.

Learning objectives

¢ Convert DDS screens in an existing application to a Web browser user interface using the IBM
WebFacing Tool

¢ Customize the Web browser user interface after conversion

* Run the customized WebFacing application

* Deploy a WebFacing application to a product WebSphere Application Server
* Mix a WebFacing and non-WebFacing application

180 minutes
Related information

&= [View the PDF version|

Introduction

While creating a browser user interface, you will learn how to use the IBM WebFacing Tool. You will
customize the output of the conversion process using the IBM WebFacing Tool and the LPEX Editor.
Next, you will learn how to run the WebFacing application in the WebSphere Test Environment that is
part of the product. You will also learn how to use Page Designer to customize the application start page
and you will learn how to publish and deploy your WebFacing application to a remote WebSphere
Application Server (this is an optional module). Finally you learn how to run a WebFacing and
non-WebFacing application using the IBM WebFacing Tool in Host Access Transformation Services
(HATS) for System i.

Learning objectives

¢ Review an existing 5250 order entry application before creating a browser user interface for it
* Create a WebFacing project for the converted application

* Convert DSPF and UIM source

* Run the WebFacing application in the WebSphere Test Environment

* Customize the WebFacing application browser user interface

* Run the customized WebFacing application in the WebSphere Test Environment

* Deploy the customized WebFacing application to a production server

* Enhance the WebFacing application browser user interface further using Web Tools

* Run a mixed WebFacing and non-WebFacing application
Time required

This tutorial should take approximately 180 minutes to finish. If you explore other concepts related to this
tutorial, it could take longer to complete.



Skill level

Introductory

Audience

System i programmer

System requirements

IBM Host Access Transformation Services (HATS) for System i V 7.1 product with the WebFacing tool
installed and all software updates through the IBM Installation Manager.

Rational Developer for System i (RDi) Version 7.1.

i5/0S® V5R2 or greater (V5R4 or greater is necessary for the part in this tutorial where you mix a
WebFacing and non-WebFacing application).

The WebFacing runtime server is started:
— STRTCPSVR *webfacing
— Verify jobs QQFWFSVR and QQFVTSVR are running. Use the command WRTACTJOB JOB(QQF*).

Make sure the user ID starting the WebFacing server has *USE authority for *PUBLIC user for object
type *LIB and object type *OUTQ.

System i~ Access for Windows® or IBM Personal Communications with 5250 emulation

IBM WebSphere Application Server for i5/0S is installed on an i5/0S system (required if you want to
do the optional module on deploying your WebFacing application to a production server). Your

administrator will need to set up and start the WebSphere Application Server and an associated HTTP
server on your i5/0S server.

Check with your system administrator to ensure that your user ID has the necessary authority to create
and access IFS folders.

Prerequisites

Basic Microsoft® Windows operations such as working with the desktop and basic mouse operations
such as opening folders and performing drag-and-drop operations

Basic knowledge of how Web applications work

Basic knowledge of how to use a browser to navigate the Internet
Restore the WFLABXX savefile (WFLABXX.savf) on an i5/0S system:
— Import wflabxx project in WFLABXX.zip to your workspace.

— Open the Project Explorer view by clicking Window » Show View » Other » General »> Project
Explorer.

— Expand the wflabxx project.
— Right-click the wflabxx.savf savefile, and select Restore on i5/0OS.
Extract the file WFDEMO.zip to your C drive:

— Open the Project Explorer view by clicking Window » Show View > Other » General »> Project
Explorer.

— Expand the wflabxx project.

— Right-click the WFDEMO.zip file, and select Export.
— Export the file to the local file system.

— On the local file system unzip the file WFDEMO.zip.

If you move the WebFacing applications to production, you need to buy a Host Access Transformation
Services (HATS) license. Without a valid license, you are limited to two concurrent trial WebFacing
connections.

Web-enable a 5250 application using the IBM WebFacing Tool



Expected results

Upon completion of this tutorial you will know how to use the IBM WebFacing Tool to create and
customize a browser interface for an existing customer inquiry application written in RPG.

Conventions used in this tutorial

* Bold font for user interface controls

¢ Mono-spaced font for user input and code blocks
* Italic font for variable names and glossary terms

Reviewing the 5250 order entry application

This module teaches you how the existing application green screens, command keys and help panels
work and look before you start using the WebFacing Tool to convert it. You will become familiar with the
5250 screens and the behavior of the application so that after conversion with the WebFacing Tool you
will then be able to compare the 5250 and the Web user interface.

Completing this module will also test your user profile setup. If you can run this application directly
without changing the job environment on the i5/0S, the WebFacing conversion and the WebFacing server
will not have problems during the remaining lessons later.

You will use a 5250 emulation screen to start the sample Order Entry application. You will be prompted
with the first screen for a customer number. You will work with the help panels this application provides.
You will select a customer from the list of valid customers and then go through the steps of filling an
order by specifying the quantity ordered. After all parts and their quantities for this order have been
specified you complete the order by pressing a specific command key. The application will then prompt
you for a new customer number to handle the next order.

Tip: If you have problems make sure the library list for your job is setup correctly to include library
WFLABXX at job start up.

Learning objectives

* Start a 5250 emulation session

* Call the order entry application

* View the customer selection screen

* Display help for the customer number field
 Display help for selecting a customer

* Display help for specifying a valid customer number
* Display extended help for the customer number field
* Display the customer selection list

* Select a customer from the list

* Display the parts selection list

* Select a part from the list

* Specify the part quantity

¢ Accept the order

* Exit the application

Time required

This module will take approximately 5 minutes to complete.
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Starting the 5250 application

You need a 5250 emulator on your workstation to start the order entry application.

To start the 5250 application:

1. Start a 5250 emulation session.

2. In the User ID field, type your user ID.

3. In the Password field, type your password.

4. On the command line of the 5250 screen, invoke the Order Entry Application: CALL ORDENTR

The application starts and shows the first panel. This first screen prompts for a customer number. You
have a choice of keying in the customer number directly or you can press command key F4 to display
a list of existing customers.

1 Session A - [24 x 80] =10 x|

File Edt Wiew Communicskion Actions ‘window Help

o3| Pl 2m| = % 2= 8 @

Farts Order Entry

ess Enter.

nber o o 4 4w . . Order number 0 o 0 0 0 W

F3=Exit Fad=Prompt FE=fAccept Order

=

EH

5
|Cc-nne-:ted to remote serverfhost toras ||:u:|1EIl on psprinkl:pd101 4

You have started a 5250 emulation session, invoked the order entry application and seen the customer
selection screen.

Lesson checkpoint

You learned the following:

* How to start the 5250 emulator from your workstation
Accessing the online help

Before you go ahead with the order entry process, try the help. This application uses User Interface
Manager (UIM) help. You will also convert these UIM help panels with the WebFacing Tool. To
understand the results of the UIM help conversion, try the help in the 5250 environment and then later in
the browser.

1. Move the cursor to the Customer number field.
2. Press command key F1.

Panel group help displays for the customer number.
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To see more help, move the cursor underneath the 1 in the help area and press the Enter key.

Help for requesting a customer list displays:
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Press command key F12 to return to the help for the Customer number field.

To see help for the second choice, move the cursor underneath the 2 in the help area and press the
Enter key.

Now you see detailed help for specifying a valid customer number.
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6. Press command key F12 to leave the help for the Customer number field.
The main help panel in the Select Customer - Help area shows.

7. Press command key F2 to get to the extended help.
Here you see the extended help for the Customer number field.
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8. Press command key F12 to leave the extended help for the Customer number field.

9. Press command key F12 again to leave the help for the Customer number field.

You have displayed help for the customer number field, for selecting a customer, for specifying a valid
customer number and extended help for the customer number field.

Lesson checkpoint

You learned the following:
* How the online help works in the 5250 application

Selecting a customer

Now you have an understanding how the help panels in this application work and look. Next you need
to identify the customer related order. You have the choice of specifying a valid customer number, or you
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can get a selection list of valid customers. Use the selection list because it shows a record format that uses
the WINDOW DDS keyword and so you can see how the WebFacing Tool converts a DDS window.

To select a customer:
1. Press command key F4 to display the customer selection list.
A list of customers displays.
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2. In the Opt field, type 1 to select a customer.
3. Press the Enter key to proceed.

This returns you to the initial panel now filled with detailed data for the selected customer.
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You'll notice that an order number has been assigned as well. You are ready to order some parts.

You have displayed the customer selection list and selected a customer from the list.

Lesson checkpoint

You learned the following:

* How selecting a customer works in the existing 5250 application
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Filling the order

The process of selecting parts is similar to the way you selected a customer in the previous lesson. You
are able to key in the part number directly or select the part from a selection list. Next you want to work
with the parts selection list.

On the order entry panel:

1. Press command key F4 to see a list of available parts.
The Select Part panel opens.
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2. In the Opt field, type 1 next to a part that has lots of quantity left and press Enter.
Back on the order screen, the part appears in the order; on the top line of the parts list.
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Next you order a certain quantity of this part.

3. Change the Qty field to a value, for example 2.
4. Press the Enter key to add the part and quantity ordered to the order.
The detail order line for this part, with the quantity specified, is now part of this order.
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Add more parts until your order is complete.

5. Press command key F4 to see a list of available parts.
6. Select a part from the parts list and press Enter.
7. Specify the part quantity and press Enter.

You have displayed the parts selection list, selected a part from the list and specified the part quantity.
Lesson checkpoint

You learned the following:
* How the order entry panel works in the 5250 application

Completing the order

Now you are ready to accept the order. You use the Order Entry panel to complete the order.

To complete the order:
1. Press command key F6 to accept the order.

The order is added to the database and the next order can be filled. You return to the starting screen
of the application.

You have worked with all panels in this application:
* The start order entry panel
* Several help panels
¢ The customer list window
* The full order entry panel
* The parts list window
2. Press command key F3 to exit the application.
You are now ready to put a brand new user interface onto this application.

You have accepted the order and exited the application.
Lesson checkpoint

You learned the following:

* How the application works to complete an order

Web-enable a 5250 application using the IBM WebFacing Tool
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Module summary

In this module, you learned how the order entry application green screens, command keys and help
panels worked and looked.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* How to start a 5250 emulation session

* How the application works

Assessment
* How do you start a 5250 emulation session?
* How does the 5250 application work?

Creating the WebFacing project

Before you can use the WebFacing Tool to reface your application you need to create a WebFacing project
in the workbench. The first step when starting with the WebFacing Tool is to create a WebFacing project.
You will identify the project information, like the DDS source member names to be converted using the
WebFacing Tool, and they will be stored in a workspace on your workstation. You will proceed through
the process of identifying the DDS and UIM Panel Group source members to be converted by the
WebFacing Tool and specify some of the runtime information you will need later when running the
WebFacing application.

Learning objectives

* Start the product

* Set the default workspace

* Access unique views and tools targeted towards the WebFacing tasks
* Specify a name for your WebFacing Web Project

* Select a Web style for your converted application

* Connect to an i5/0S server

* Select source members to convert

* Specify the CL command to invoke the application

* Specify the application signon values

* Create the WebFacing Web Project without converting files

Time required

This module will take approximately 25 minutes to complete.
Starting the product

Now go ahead and start the product.

To start the product:

1. On the desktop task bar click Start > Programs > IBM Software Development Platform > IBM
Rational HATS 7.1 > HATS Toolkit 7.1.
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IEM Rational Develaper Far Systemi ¥

IBM Rational Application Developer  ®
ﬁn 2

Certificate Management

|&] HATS Website
@ Information Cenker
g] Release hotes

A dialog appears asking you for the workspace location, unless you used the product before and

selected not to show this dialog again.

The workspace contains all the information about your projects. You can accept the default or store

the work related to this tutorial in a separate workspace. You can always start with a new workspace

later, if you don’t want to mix these exercise WebFacing projects with your real work.

o) Workspace Launcher

Select a workspace

Choose a workspace folder to use For this session.

Websphere Development Studio Client Advanced Edition for iSeries stores vour projects in a folder called a workspace,

P Y

Waorkspace: IC:'l,DUcuments and Settings'|,.0.c|ministrat0r'|,rati0na|sdp?’|wﬂabxx| '

[ Use this as the defaul: and do not ask again

e

j Browse. .. |

Cancel |

Accept the default directory structure but change the name of the workspace directory to the name

WFLABxx where XX is a unique number.
Click OK.

After a few moments of loading, the workbench opens, and the initial window of the product opens.

Web-enable a 5250 application using the IBM WebFacing Tool
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& Remote System Explorer - iSeries RSE Getting Started - Websphere Development studio Client Adv|

File Edit Mavigate Search Project Data Run Window Help

Note: If you didn’t reset the workspace your environment will differ slightly from the screen captures
in this tutorial.

You have started the product and set the default workspace.
Lesson checkpoint

You learned the following:
* About workspaces
* How to start the product

Opening the WebFacing perspective

The workbench shows the HATS perspective by default. The Remote System Explorer (RSE) perspective
is the perspective that you would use to work with i5/0OS objects. It allows specifying connections to
i5/0S servers and provides for the programmer a similar interface to i5/0OS objects as the Program
Development Manager (PDM) does in a green screen environment.

The WebFacing Tool provides it’s own perspective since it needs to give its users access to unique views
and tools targeted towards the WebFacing task. To create a WebFacing Web project you can either open
the WebFacing perspective or you can create a WebFacing Web project without opening the WebFacing
perspective. To create a WebFacing Web project without opening the WebFacing perspective, see the next
lesson.
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To open the WebFacing perspective:

& Remote System Explorer - iSeries RSE Getting Started - Websphere Development Studio Client Advanced
File Edit Mavigate Search Project Data Run

e Mew YWindow
Mew Editar

Shiow Wiew

Customize Perspective. ., WebFaring

Save Perspective As...

Reset Perspective
Click Window > Open Perspective > WebFacing from the workbench menu.

The workbench now shows the WebFacing perspective with the WebFacing Projects view open in the left
pane of the workbench.

o WebFacing - Welcome to WebFacing - Rational Application Developer k
File Edit Mavigate Search Project Data Run Window  Help

J[:ﬁ' J Jﬁ'ﬁ’%’ Jlﬁﬁé}@"l T | [ WebFaring >
J[gqnj;;jvj@ J ] T el o hd EHDstF\ccessT...

[H WebFacing Proj.. 2 Navigator| = 0| welcom.., 251 T O m

« || |An outline is nok =vailable,

Welcome =
to

WebFacing!

With the IEM
WebFacing tool in
Host Access
TransFormation
Services (HATS)
toolkit, wou can
conwvert the user
interface of your
51035 business
applications inko a
Web user inkerface,
Your converted i5/05
=l proper... 52 . Gallery | WebFa, .. | = B || obs display File

B % — || source members are

- deploved as a Web

Propert | value | application that
communicates with I
-
| »

vaur original program
logic when accessed

Frlom a browser. The
4

§5i Thumbnails &3 Styles | Colors | Liriks | Servers | Wwheb Sett.., | =0
Al Files (*.%) I
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You are ready to start the WebFacing project wizard to create a WebFacing project.

You have accessed unique views and tools targeted towards the WebFacing tasks through the WebFacing
perspective.

Lesson checkpoint

You learned the following:

* About the RSE perspective

* About the WebFacing perspective

* How to open the WebFacing perspective

Starting the WebFacing Web Project wizard

A WebFacing project is a complete Web project with the directory structure and files needed to conform
to the Java " 2 platform, Enterprise Edition (J2EE) standard of a Web application. It also contains
additional information unique to WebFacing, like the source to be converted.

To start the WebFacing Web Project wizard:

1. In the WebFacing perspective or the Remote System Explorer perspective, click File > New >
WebFacing Web Project from the workbench menu.

o WebFacing - iSeries RSE Getting Started - Websphere Development studio Clig
Edit Mawigate Search Project Data Run Window Help
k

=

[ 7] Project...

Ale+Shift-HY

Open File. ..
bFacing ) Project

Close Crk-hid FEf HATSWebFacing Enabled Proj

el il tg "WebFacing Portlet Project
| Ctrls A

[ Example. ..

. Save A5, ..
W sl chrlshifers | D7 Gther..

& Remote System Explorer - iSeries RSE Getting Started - IBM Websphere Devel

File Edit Mavigate Search Project Data Run  SWindow Help

A s I~ Project...

Open File. ..
& iSeries Library
Closs ChrlH Ll‘_j iSeties Source Physical File
Close Al Ctri4-Shift - [ iseries Source Merber
B Chrl+5 (i 15eries Message File
. Save fs... D”:{ i9eries Data Queus
Wy sl Chrlsshift+s  (fjiSeries Data Area
Rewverk bFacing Web Project
e fEi HATSWebFacing Enabled Project
Bl 2 fg.] WebFacing Portlet Project
HEefresty FS £ Example. .
Caorwvert Ling Delimiters To »
ol Print. Chl4p Wi

This will start the WebFacing Web Project wizard.
2. In the WebFacing Web Project wizard you will be presented with the WebFacing Web Project page.
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# webFacing Web Project [ x|

webFacing Web Project [

Create a WebFacing Web Project ,-* %

Project name: I wiflabi]

~Project contents:
¥ Use default

Direckary: IC:'l,DUcuments and Settings\idbox\ IEMirationalsdp 7., 0ywlabeocFebDEwilabao: Browse. ., |

— Targek Runtime

IWebSphere &pplication Server w6.1 j Mew,.. |

r— Configurations

|<custc-m> j

Hink: Get started quickly by selecting one of the pre-defined project configurations,

— EAR Membership
v add project to an EAR

EAR Project Mame: | whlabxxEAR j New...l

[~ Configure advanced settings

@ = Back I Mexk = I Finish | Cancel |

3. In the Project name field, type the project name wflabxx where XX is a unique number.
4. Click Next.
The Web Style page opens.

You have specified a name for your WebFacing Web Project, and accepted default values for the Project
Facets page, Web Module page and Struts Settings page.

Lesson checkpoint

You learned the following:
* About WebFacing projects

* How to start the WebFacing project wizard and give a name to the WebFacing project
Selecting a Web style

Next you select a Web style for your converted screens.

To select a Web style:
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o WebFacing Web Project

Choose a Web Style

Select a "Look and Feel” style to use for the project,

" Enable For Web Site Designer

¢ Seleck classic WebFacing style

Select a predefined or previously customized style:

avenie
corporatel
financialGreyRedtones

Bly Company Name

Fans Onder iy

e

i . L
fun = ;

ot

kexthuttons

L7 < Back | Mext = | Finish I Cancel

1. Select the gradient style from the list of available styles
2. Click Next.

The Select Source Members To Convert page opens.

& WebFacing Web Project =2

Select Source Members To Convert

Select "Refresh list" to refresh the library items displaved in the tree. Select members from the tree and add them to the i
kable For conversion, V 4

Project name:

I wiflabio

Connection name:

| j New...l

Library: File:

Mermber: Type:

=] [Em =] | |psPrMmuDDS PRLGRP v ]

Click the Refresh list buttan, then select files or members and add them to the table for comversion:

Refresh list |

Librar I File I Member I Type I

}}'
<<|

<Back |{ Next>

Finish I Cancel
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You have selected a Web style for your converted application.

Lesson checkpoint

You learned the following:

* How to select a Web style for your converted application
Selecting source members to convert

On this page of the WebFacing project wizard you need to specify the name of the i5/0S server that

contains your source members of the source file you want to convert. Specifically, the WebFacing Tool
needs to know these names:

* Server name
e Library name
* Source file name

* Member name

First since you are starting with a new workspace, you need to specify the i5/0S server name to specify
where the Data Description Source (DDS) is located.

1. To connect to an i5/0S:
a. Click New beside the Connection name list.

o WebFacing Web Project | |

Select Source Members To Convert

s
Select "Refresh list" to refresh the library items displaved in the tree, Select members From the tree and add them to the  J——
table for coneeersion, V il

Praoject name:

| wiFlabs:

Caonnection name:

L
Library: File: Member;: Type:
=] [Em =l =] JoseFmmuoosPure 7]

The Name personal profile page opens.
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‘b New
Name personal profile
Uniquely name user profile :l!b

‘Welcome to Remote Systems. Connections can be sharable by the team or
private ko vou, Enter a profile name ko uniquely identify wou From your team
members, You will decide for each new connection whether it is owned by the
team profile or vour profile.

Prafile: | pleiades

(7) < Back I Mext = I Finish | Cancel |

b. Accept the default profile name as this is your own private connection.
c. Click Next.
The Remote i5/0S System Connection page opens.

Remote i5/0S System Connection
Define connection information :H':
Parent profile: Ipleiades j

Cannection name: | 54003

Hast name: I 54004 j

Description: I

W Merify host name

@ < Back | Mext = | Finish I Cancel |

d. In the Host name field, type the name of the host system, for example s400a.

Note: This is your i5/0S server name; don’t use the one shown unless your system is named
s400a.

The connection name will be filled automatically with the same value.
e. Leave the Verify host name check box selected to verify that the host name or IP address exists.
f. Click Finish.

The connection is created and can be re-used by all tools in the workbench.The connection wizard
also checks whether the i5/0S host can be reached and if this test is successfully completed, you
return to the Select Source Members To Convert page.

g. Check that your i5/0S server is selected in the Connection list.
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# webFacing Web Project

Select Source Members To Convert

Select "Refresh list" ta refresh the library items displayved in the tree, Select members Frarm the tree and add thern bo the
table For conversion,

Project name:

I wilabio

Connection name:

‘ls4UDa ’

Library: File: Member: Type:
@ =] [Em =] [em | |psPFmmunDs PrLGRE 7]
h. Make sure that *LIBL is selected in the Library list.
i. Click Refresh list.
S WebFacing Web Project [ |

Select Source Members To Convert

Select "Refresh list” to refresh the library items displayed in the tree. Select members from the kree and add them ko the V/—
table for conversion, { il
Project name:

I wiflabi

Connection name:

|s400a

Library: File: Mermber:

=1 [am =] [am

h lisk button, then select files or members and add them ka the table for conversion:
Crreshi)

A User ID and password dialog opens.
x

System type: 505
Host name:  TORAS3SE
User ID: I wilabio:

Tvpe:
| |psPFmmupDSPRLGRE 7]

Password; I HkdAk

v Save user ID

(4] 4 Cancel |

j. In the User ID field, type your user ID. Use the same user ID that you used when running the
Order Entry application in [‘Reviewing the 5250 order entry application” on page 3.

k. In the Password field, type your password.

[. Select the Save user ID check box.

m. Select the Save password check box.
n. Click OK.

A connection to the i5/0S server gets established. The library list of your i5/0S job is displayed

under the Refresh list button on the Select Source Members To Convert page.
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Refresh lisk |

I TORASIIE ¥LIBL *ALL ¥ALL DSPF MMUDDS PR

B-Egh Q5YS
-2 GsYse
H-2h GHLPSYS
- QUSRSYS
- QGPL
-2 QTEMP

Next you select DDS source members:
2. To select DDS source members:
a. Select the WFLABXX library from the list.
b. Click the plus sign (+) beside the WFLABXX library to expand it.

& webFacing Web Project [ x|
Select Source Members To Convert | '
3 members added For QDODSSRC 7 i
S

Praject name:

| wilabc

Caonnection name:

|s4EIDa j Meww. .. |

Library: Files Member: Type:
=] [Em =] [m =l [psermmoosPrGre x|

Click the Refresh list button, then select files or members and add them ko the table for conversion:
Refresh list |

I TORASIIE *LIBL *ALL *ALL DSPF MNUDDS PHL

Bk QSYS =
B QY2

~EEL QHLPSYS
- QUSHSYS

-5 QRPGLESRCP

: |
Tl ™ ~eml

(7) < Back | Mext = Finish Cancel

c. Select the QDDSSRC source file from the expanded list.
d. Expand QDDSSRC and select all members from the list.
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e. Click _>> | push button in the middle of the page to copy the selected members over to the list
of members to be converted at the right.

Tip: To move all members in a source file you can select the source file icon itself and click the

> | push button. This will add all members in a source file to the list of members to be
converted.

The WebFacing Tool now knows which DDS members to convert for this project. The conversion
hasn’t been done but the information is stored for future use.

Next you select UIM source members.
3. To select UIM source members to convert:
a. Select the QPNLSRC source file from the expanded list of library WFLABXX.

& webFacing Web Project [ x|

Select Source Members To Convert =

1 members added For QPMLSRC l/—"
b’

Praoject name:

| wilabee:

Connection name:

[s400a =] e |

Library: File: IMember: Tvpe:
=] [Em =] [Em | |psermmcos prcre 7|

Click the Refresh list bukton, then select files or members and add them to the table For conversion:

Refresh list |

| TORAS33B *LIBL *ALL *ALL DSPF MNUDDS PHL Librar | File | Member | Tvpe |
WRLABRY QDDSSRC ORDENTD DSPF
BBk QY5 L] WFLABKY QDDSSRC SLTCUSTD DSPF
BB, Q552 QDDSSRC SLTPARTD DSPF

ORDEMTRPMNL

PRLGRP

CPMNLSRC

F-B QHLPSYS
- QUSRSYS

= Bk, WFLABRY =
S QCLSRC

QDOESRC == |
QDDSSRCP
CPMNLSRC
CPNLSRCP
QRPGLESRC
56 QRPGLESRCP Ll

I = ~em

(7 < Back | Mext = | Fimish | Cancel |

b. Click _>> | push button in the middle of the page to copy all members over to the list of
members to be converted at the right

There is actually only one panel group member ORDENTRPNL in this source file.
c. Click Next to proceed to the next page of the wizard.
The Specify CL Commands page opens.

You have connected to an i5/0S server, selected DDS source members and UIM source members to
convert.
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Lesson checkpoint

You learned the following:

* What the WebFacing Tool needs to know to convert source

* What happens if you miss selecting a record to convert

* How to connect to an i5/0S and select DDS and UIM source

Specifying the CL command to launch the application

You will now provide the information that will allow the WebFacing Web Project wizard to create the
initial index.jsp page to start the Order Entry application. Do you remember what you typed on the
command line to start the Order Entry application in the 5250 emulation session during the first exercise
in [“Reviewing the 5250 order entry application” on page 3P In case you forgot; it was: CALL ORDENTR

Why should you remember? The WebFacing run time needs to know the invocation command for your
application in order to send this invocation command to the i5/0S server to start your application from
the browser. The page in the WebFacing Web Project wizard will allow you to specify the necessary

information CL command and Sign on information.

@ webFacing Web Project x|
| =

Specify CL Commands

Enter the CL commands that are used in vour application, the command labels vou want to use, and the signon preference ,-_*
for the generated hypertext links,

Project name; I f

WebFacing generates hypertext links that vou can use to launch your application From the Web, In order ko do this, it needs ko know the
text that will be shown For each link and the CL command that each link will invoke. ©On this page wou can define multiple links, in case
several CL commands are used to launch vour application.

If wour program requires parameters, you can enter them as wariables in the CL command, For example: to invoke program MYPEM with a
part number parameter, vou would enter CALL MYPGM PARM(&part) as the CL command. The variable "&part” will be replaced when you
click on the invocation link. For details, refer ko the generated index. jsp File. The invocakion name is used to uniguely identify each
hypetlink in the index, jsp filz,

CL command: I CALL ORDEMTR.

Command label: | Order Entry Application

Invocation name | INV1
' /

" Prompt for signon
[adifay

[5' Specify i5/035 signon values ]

UserID | WFLABH:

Password I****** Confirm password I******
L Commanid | Caommand Label | Invocation nane | ser ID |
Delete |
[Mowe Up
Morve Down |
@ < Back . Einiish Cancel

To specify the CL commands:
1. In the CL command field, type CALL ORDENTR
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2. In the Command Label field, type Order Entry Application.

Tip: If you don’t type anything into the Command Label field, the CL command input will be copied
into this field.

3. Leave the default value INV1 in the Invocation name field.
4. Click the Specify i5/0S signon values radio button.

This will automatically apply the user ID and password you used when you connected to your i5/0S
server in the previous dialog for selecting source members for invocation of this application. You will
use this setup here for testing purposes to make it easier for you to start the Order Entry application
without specifying the authentication information. Don’t worry about security in your production
environment, this can be easily changed later and you will see how to do this later in this tutorial.

5. Click Add on the right side of the page.

Tip: Make sure the text and command you typed into the fields are actually shown in the CL
Command table at the bottom of the page.

6. Click Next at the bottom of the wizard page.
The Complete WebFacing Project page opens.

You have specified a CL command to invoke the application and the application signon values.
Lesson checkpoint

You learned the following:

* What the invocation command does

* About the information required to create the Web page to start the application
* How to specify the CL command to invoke the application

Completing the WebFacing project information

On this page you have a choice of creating the project and converting the source in one step or only
creating the WebFacing project.

You will just create the WebFacing project. You don’t need to convert the source now. Conversion is part
of the next module.
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@ WebFacing Web Project

Complete WebFacing Project

You hawve indicated the specifications For your new WebFacing project. To continue, click Finish. 1

‘fou are about to create a WebFacing project.
Do you also want to corvvert the selected display files?

" Yes, Iwank ko create the project and proceed with conversion n%.

@‘\lo. I only want to create the project now,

< Back | M{Exk = | Cancel |

To complete the WebFacing project information:

1. Select the No. I only want to create the project now radio button.
2. Click Finish.

The WebFacing project is created.

Tip: If you created the WebFacing Web project from a different perspective, you will see a dialog
asking you to confirm the switch of the perspective to the WebFacing perspective. Click Yes.
‘b Open Associated Perspective?

9P ) This kind of project is associaked with the WebFacing perspective, Do wou
““-‘I’J wankt ko open this perspective now?
ermember my decision
" Rememb decisi
Yes Mo |

The workbench opens in the WebFacing perspective with your new WebFacing project in the
WebFacing Projects view.
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In the expanded wflabxx project you'll notice several files and folders have been added to this
WebFacing project:

* The information for display file source members to be converted

* The information for panel group source members to be converted

* The CL Command that will be used to start the Order Entry application
* The style to be used for the converted screens.

When you expand the folders and files under your WebFacing project you can see the information
that is captured for this project.

=1 i wflaboc |

EIEE CL Commands

L0 CALL ORDENTR
DDS
| <TORASIIE >WELABYY/QDDSSRCIORDENTD)
| <TORAS336 >WFLABKY/QDDSSRCISLTCUSTD)
| <TORAS33E >WFLABYY/QDDSSRCISLTPARTD)
E-C% UM Help
- B0 <TORASIIE-WFLABXY/QPNLSRC(ORDENTRPNL)
C% style
@ index.jsp
[ logon.jsp

‘WebFacing Projects Mavigatar | - =

3. Click each folder or file. Click the plus + sign beside each file or folder.

Tip: If you later need to add source members to the WebFacing project, right-click the DDS or UIM

help icon and click Add on the pop-up menu. This will launch the WebFacing Web Project wizard and

display the correct dialog.
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B= ‘WebFacing P Mavigator - =

= ﬁ wiflabne
EI[-E CL Commands
el caLL ORDENTR
DS

rojects

B

<TORASIZE =WFLABK:/QDDISRICIORDENTD)
<TORASIZE =WFLABKA/QDDSSRC(SLTCUSTD)
<TORASIZE =WFLABX:QDDSSRCISLTRARTD)

LS eToll e P btORDENTRRNL)

CS’ Skyle open
] index Js Gpen wWith 3
“[&] logon,jsp

e Delete g
= Properties &3 Style » ]712'5
Conwert = }:b =

Proéerti I \ et o

License Setbings...
Link. with 3

Properties

You have created the WebFacing Web Project without converting files.
Lesson checkpoint

You learned the following:

* About the files added to the WebFacing project

* How to create the WebFacing project without converting files
* How to add source members to an existing project

Module summary

In this module, you created a WebFacing project and in this project you specified which display file
source and panel group source to convert and which i5/0S server these source members are located on.
The WebFacing Tool will use this information during the conversion process.

You have to specify in this next module whether you want to convert all source members belonging to
this project or selected ones only. A word regarding security, in case you are wondering, why you don't
have to logon to the i5/0S server during conversion, it is because, your user ID and password have been
stored during the WebFacing project setup, and will be re-used here.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* About the workspace

* About the WebFacing perspective

* How to start the product

* How to set the default workspace

* How to access unique views and tools targeted towards the WebFacing tasks
* How to complete the WebFacing Web Project wizard

Assessment
* What is the WebFacing perspective?
¢ What is a WebFacing project?
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* How do you invoke the WebFacing Project wizard?
* How do you create a WebFacing Project using the WebFacing Project wizard?

Converting selected source members

This module teaches you how the WebFacing conversion creates the JSP files for the browser User
Interface description, XML files for record format layouts, and several other files needed for the Web
application. You will learn how to select the convert option, start the conversion and work with the
conversion logs to check the results of the WebFacing conversion.

Learning objectives

* Select members to convert

* Convert members

* Check reference keywords for errors

¢ Check the DSPF conversion log for errors
* Check the UIM conversion log for errors

Time required

This module will take approximately 10 minutes to complete.

Selecting the project and source members

You will use the product to do the WebFacing conversion, if it is not up and running already, start it now.
If it is still up and running on your workstation you are ready to go ahead.

If the WebFacing perspective with your project is not visible, you need to open the WebFacing
perspective.

1. To open the WebFacing perspective:

a. Check the taskbar of the workbench for the WebFacing perspective icon and if you find it, click on
the icon to switch to the WebFacing perspective that is already open but not active at the moment.

Tip: Avoid having too many instances of the same perspective open. It will improve performance
of the workbench if you restrict yourself to one instance of a specific perspective being open. We
have seen situations with 50 perspectives being open at the same time; this has caused severe
performance impacts, so be careful.

Here you see the icons on the taskbar of the workbench. The Remote System Explorer perspective
is active. The workbench window title bar shows this. Four perspectives are open in the
workbench.

ent Studio Client Advanced Edition for iSeries

Wwindow Help

ﬁ'%'J@E‘?@'J%J@Q“ B @web &laava 2
E‘EWebFacing

E Remate Syske, ..

. @ The WebFacing perspective

ﬁ The Remote System Explorer perspective

. ﬂ The Java perspective

E The Web perspective
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b. To switch to the WebFacing perspective. Select its icon @ from the taskbar.

Tip: The icon E on top of the taskbar allows you to open a new perspective.
Next you start the conversion in the WebFacing perspective.
2. To select members to convert:
a. Select the WebFacing project you have been working on in the previous module, wflabxx.
b. Expand this project by clicking the plus sign (+) beside its icon in the WebFacing Projects view.

™ ‘WebFacing Projects &3 Navigatc-r| =

= Iﬁ wilab

El[_a CL Commands
- L0l caLL ORDENTR
DS

i <TORAS3IE >WFLABKY QODDSSRCLCRDENTD)
(L <TORAS3IE=WFLABXXIQDDSSRC(SLTCUSTD)

: <TORASIIE =WFLABRXIQDDSIRC{SLTPARTD)
E-C% UM Help

"'C? <TORASI3E =WFLABK K/ QPMLSRC{ORDENTRPML)

C:S’ Style
@ index.jsp
[ logon.jsp

You should see a DDS folder in the expanded view.

If you don’t see a DDS folder, you might be in the Navigator view and not in the WebFacing
Projects view.

c. Expand the DDS folder, so that you can see all three of the members that you selected in the
previous module.

Next you convert these members.
You have selected members to convert .
Lesson checkpoint

You learned the following:
* About perspectives
* How to select members to convert

Starting the WebFacing conversion

From here you can select individual members to convert or a collection of members. When you later in
this tutorial change only one source member you will select a single member to be converted. Since you
want to convert all members in the project, you can actually work with the WebFacing project icon to
convert DDS and UIM panel group members.

Tip: You could select individual members to convert as well as expanding the DDS node.
1. Right-click the wflabxx WebFacing project.
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Mavigatar = EW = o
|

e With .
Add
Delete,..
B0 UM style .
e
C:S’ Shyle

&l inde Wiew Log
e[ logan License Setkings...

Lirk: Wfithy L4

2. Click Convert on the pop-up menu.

The conversion process starts. You will see a progress dialog, indicating what members are being
converted.

Progress Information

-
\1 J Converting 3 - 3.

| INNER
Parsing: < TORASI3E >WFLABXY/QDDSSRC(SLTPARTD)

Cancel

Wait until the progress dialog disappears, indicating the WebFacing conversion has finished.

You have converted members.
Lesson checkpoint

You learned the following:

* How to convert members
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Checking the conversion logs

Notice the conversion log in the right pane of the workbench.

E iSeries RSE Getting Started | o ‘webDiagram. gph 8= wllabs: Log X ==

| »

DSPF Conversion Log

Display Files Records
This section lists all display Files that This section lists all the records in the
have been converted, converted display file,

(8 WFLABX X QDDSSRC(ORDENTD)
(& WFLABXX/QDDSSRC(SLTCUSTD)
(& WFLABXE/QDDSSRC(SLTRARTD)

Errors

This section lists all errors for the selected object,

all rmessages
Compile messages only
Conversion messages anly
Message ID | Line | Severit Message Text |

-
Pl | »

Cveryieu | Referenced Kewwords lDSPF Conversion LDgJ UM Help Conversion Log | I

To check the conversion log;:

1. Click the Overview tab.

2. Click the Reference Keywords tab.

3. Click the DSPF Conversion Log tab.

4. Click the UIM Help Conversion Log tab.

As you click each tab you will see more details about each log.

You converted the DDS source and panel group source so it is now available in a form a browser
understands. The first important step to move your application to the Web is done. Notice, the
conversion itself was pretty easy, because you already did the hard part when you created the WebFacing
project. Now that the project exists, the WebFacing Tool has all the information readily available, and
even having to re-convert later because of changes in the original source is not a big problem.

Lesson checkpoint

You learned the following:

* How to check the conversion logs

Module summary

You have used the WebFacing Tool to convert the user interface of the Order Entry application and you
now want to see the conversion results. The WebFacing Tool created a complete Web application that can
be run in an Application Server. The WebSphere Application Server test environment and the Web project
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in the workbench are completely integrated and without publishing (copying) any of the files in the Web
project they are known to the WebSphere Application Server test environment.

The index jsp file that has been created by the WebFacing conversion routine is part of this Web project. It
will be used as the default page for this Web application. When the application is up and running you
will go through the same scenarios as in [‘Reviewing the 5250 order entry application” on page 3[ when
you went through the green screen panels of the Order Entry application but now you are using the new
WebFacing user interface.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Select members to convert

* Convert members

¢ Check reference keywords for errors

* Check the DSPF conversion log for errors

* Check the UIM conversion log for errors

Assessment

* How do you select members to convert?
* How do you convert members?

* How do check for conversion errors?

Running the WebFacing application

You normally would now have to copy all the files of your Web project to a WebSphere Application
Server and then run your application there. However, there is a WebSphere Application Server included
with the product and it is called the WebSphere Test Environment (WTE). Using WTE makes the process
of locally testing your WebFacing application easier than testing on a remote WebSphere Application
Server.

In your real application development environment, you would test thoroughly in the test environment;
then export the WebFacing project files to a remote WebSphere Application Server for final testing, before
moving the Web-enabled application to your production WebSphere Application Server environment.
[“Exporting to i5/0OS WebSphere Application Server (Optional)” on page 104] shows you the steps required
to deploy to a remote WebSphere Application Server environment. Until you are sure your WebFacing
application is ready for public use, you can use the test environment on your workstation, which
simplifies the testing of Web applications.

This module teaches you how to test your WebFacing application in the WebSphere Test Environment.
You will learn how to specify in the WebFacing perspective that you want to run your project in the
WebSphere Test Environment. From the initial Web page, you will learn how to select the link created by
the WebFacing Tool to invoke the WebFacing Order Entry application.

Learning objectives

* Set the WebSphere Test Environment to test the application locally
* Launch the WebFacing application

¢ Prompt for a customer

* Select a customer from a list of customers

¢ Prompt for a part

* Select a part from a list of parts

* Enter a quantity for a part
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* Display help for the customer selection list
Time required

This module will take approximately 15 minutes to complete.
Showing the index.jsp page

The first page of the application is the index.jsp page. This is the page that starts the order entry
application.

To show the index.jsp page:
1. Right-click index.jsp in the WebFacing Projects folder.

= O || & wflabxx Log 22 = =
E flab: : -
E‘E"f = DSPF ConversionLog  —
= CL Commands
E‘ [ pos Display Files
<5400 =4/FLABKA [QDDSSRC(ORDET This section lisks all display files that
54002 =WFLAE X/ QDDSSRCSLTCY have been converted,
o <s400a>WELABYODDSSRO(SLTRA -
G LIIM Help v (5 WFLABXX /QDDSSRC(ORDENTD
Cé e W (8 WRLABYE MQODDSSRC(SLTCUSTE
' - _ : (8 WELABREQDDSSRCISLTPARTE
e, js
] »
-5 logon.jsp - .
Jpen
Open With 3
He i
— \flew Log =
= Properties &2 ; (5 Licernse Setkings. .. i
Link With r |
Fraperty & 1 Run on Server plEsilieon 4
&= Info Debug As b 2 Administrative Script  AR+SHIFEEE, N
derived Profile &s 3
editable Team » 2 Run...
last modified Compare With »
linked Replace With » B Thumb, ., 23 Shyles | Colars | Links | Setv
location Source Y 1% ol Files %)
narme Page Template » —
path e o
size Properties

2. Click Run As > Run on server on the pop-up menu.
A Server Selection dialog opens.
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o o A~ W

ﬁ) Run On Server
Define a New Server -
Choose the tyvpe of server to create

How do vou want ko select the server?

" Chaoose an existing server

¢ Manually define a new server

Server's host name: I localhost j

Select the server type:

Don't see your server lisked? Click here
Eﬁ WwebSphere Portal w5, 1 For Import, Export & Deploy ﬂ
EE wehSphere Portal w5.1 Server Attach
webSphere Portal w5, 1 Test Environment

‘WebSphere Porkal w6.0 Server
|§j§' ‘Websphere w5 Server Attach

ﬁ webSphere +5.1 Server

ﬁ WwebSphere w5, 1 Test Environment
~[eall WebSphere v&.0 Server
‘WebSphere w6, 1 Server

[#-(= JBoss

-
Wiew By I\-'endor 'I

Description: Runs J2EE projects on the WebSphere v6.1 Server,

Server runtime: |WebSphere application Server vi. 1 j Installed Runtimes. .. |

®Set server as project default {do not ask again)

'Zi’jﬁ' < Bach | Mext = | Firish I Cancel |

You can avoid having this dialog open every time you select run on server by selecting the Set server
as project default (do not ask again) check box.

Leave the Manually define a server radio button selected.

Click WebSphere v6.1 Server. This is the WebSphere Test Environment for Version 6.1.
Select the Set server as project default (do not ask again) check box.

Click Finish.

The WebSphere Application Server test environment starts. A Server Selection information message
dialog may open. Click Run in Background . After a few moments the browser opens in the upper
right view area of the workbench. Be patient; it takes time for the application server to start on your
workstation.

The minimum memory requirement for running the WebSphere Application Server test environment
is 768 MB. You can run this WebFacing project successfully on systems with 512 MB. It will take more
time for the application server to start if you are working on a workstation that has less than the
required memory. The system speed will also have an impact on the application server start up time.
Eventually you will see the index.jsp page that has been generated by the IBM WebFacing Tool
opening in the workbench’s built-in browser.

Here you see the browser inside the workbench with the index.jsp page displayed.
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Tip: To enlarge the browser window to the size of the workbench window, double-click the browser
title bar. To get it back to its original size in the upper right hand workbench view area, double-click
the enlarged browser window title bar.

You have a choice of running WebSphere Application Server Version 5.1, Version 6.0 or Version 6.1 in
the workbench test environment. In this tutorial you will be using WebSphere Application Server
Version 6.1 in the Test Environment and J2EE level 1.4.

You have set the WebSphere Test Environment to test the application locally.
Lesson checkpoint

You learned the following:

* About the minimum memory required for WebSphere Application Server
* How to start the order entry application

* How to enlarge the browser window
Testing the WebFacing application

Now you are ready to run the WebFacing application that you just created.

To run the Web application:
1. In your browser pane, click the Launch button.

After a few moments the first application page opens in the browser.
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If you find the response time slow, keep in mind that the first time the JSP file is requested, it has to
be compiled into a servlet the first time. If you run the application a second time, you will see
improved performance since the servlet already exists. This is normal application server behavior.

Now you want to go through the same steps as in [“Reviewing the 5250 order entry application” on|
to review the results of the WebFacing conversion. This will give you a sense of how the
default conversion will change your original application. You will then have a chance to improve the
conversion results.

2. Click the Prompt button, or press command key F4 to open the selection list window.

Parts Order Entry

Type choices, press Enter,

S e
Customer number .. ... .. To select customer
Type choices, press Enter,
1=5Select

Opt Customer
I_ Dakley, Annig O
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3. Select a customer from the list (this is your converted subfile).

4. Press the Enter key.

5. Click the Prompt button, or press command key F4 to display the parts selection list.
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6. Select a part.

7.

10.
11.
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The Parts Order Entry window opens.
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Enter a quantity.

Press the Enter key.
Continue ordering one or two more parts.
Press command key F6 to accept the order.
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The application works the same way as before in a 5250 environment; but the application now has a
browser user interface.

You have launched the WebFacing application, prompted for a customer, selected a customer from the list
of customers, prompted for a part, selected a part from a list of parts and entered a quantity for a part.

Lesson checkpoint

You learned the following:

* How to test the WebFacing application locally in the WebSphere Test Environment

Testing the help support
Next you test the display help that you also converted in the WebFacing application.

To test the help in the WebFacing application:
1. Press the F1 key.

Another browser window opens with the help information.

i Web Browser ~=1of x|
Ihttp:ll',l'lc-calhc-st:‘. vl =S | o B | i
=)

Esttended help

Use this panel to specify a customer to work
with. Choose one of the following options:

e 1. Select
« 2. Enter nurmber

Dane

2. Now try the links:

* 1. Select

* 2. Enter number

* Extended help

Your UIM based help panels are all available in the WebFacing application.
3. Close the help browser window and press F3 to end the application.

You have displayed the help for the customer selection list.
Lesson checkpoint

You learned the following:
* How to see the help in the WebFacing application

Module summary

In this module you saw how an application looks after converting the user interface with the WebFacing
Tool. You also saw one of the standard styles available (gradient) with the WebFacing Tool. You can
customize these styles.
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Next you want to improve the user interface generated by the WebFacing Tool. You want to improve the
customer selection subfile. The Web user interface for selecting a record from this subfile does not work
like a Web application. You have to key 1 into the options column to select a record; this is how the green
screen application works. You want a Web user interface where you can click on a link to select a
customer.

You will be guided through Screen Designer and the Web Setting view to make the necessary
modifications. You will change the second column in the customer selection subfile, which contains the
customer name, from a simple text output field to a link. When you click on this new customer name
link, the correct information your program expects is sent. You might ask what is the correct information?
What is your program expecting? It is expecting a 1 in the subfile options field for the selected customer
record. The program will receive the same information after you change the user interface.

The WebFacing conversion will add logic to the user interface, so that the options field is filled with a 1
and the Enter key event is invoked when the link is pressed. You enhance the user interface and don’t
have to change the application, this sounds pretty impressive doesn't it.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Set the WebSphere Test Environment to test the application locally

* Launch the WebFacing application

* Prompt for a customer

* Select a customer from a list of customers

* Prompt for a part

* Select a part from a list of parts

* Enter a quantity for a part

* Display help for the customer selection list

Assessment

* What is the WebSphere Test Environment?

* How do you launch the WebFacing application in the WebSphere Test Environment?
* How do display help in the WebFacing application?

Changing the user interface using Web Settings and Screen Designer

In this section Screen Designer is used for illustration only, the same could be accomplished from the
LPEX view. Screen Designer is a technology preview that provides the capability to graphically design
and modify the content of DDS display files. Screen Designer should not be used in production.

Working in the WebFacing perspective you will learn how to select a DDS source member, open this DDS
member in Screen Designer, use Web Settings view to change the Web look, reconvert the DDS member,
and then deploy and run the modified WebFaced application in the Websphere Test Environment.

Learning objectives

* Locate a DDS source member

* Open a DDS source member in Screen Designer
¢ Change CUSTOMER field to hyperlink

* Hide the OPTION field

* Hide the heading for the OPTION field

¢ Change the appearance of text
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* Close Screen Designer

* Reconvert the DDS source member
* Launch the reconverted WebFacing application

* Prompt for a customer

* Verify the changes in the customer selection window

Time required

This module will take approximately 15 minutes.

Opening DDS display file source in Screen Designer

First you start the product and open the WebFacing perspective. Skip this step if the product and

WebFacing perspective are already open.
1. Start the product, open the WebFacing perspective, and view Window object in its default look and

feel:

a. Start the product and open the WebFacing perspective, if it is not up and running already.

b. In the WebFacing perspective, make sure that you are in the WebFacing Projects view and not the

Navigator view.

c. Expand your project in the WebFacing Projects view by clicking on the plus sign (+) beside the

WebFacing project icon if not already. Next you open Screen Designer.

d. Display initial look and feel of the window by starting Order Entry application and clicking the

Prompt button.

Customer List

To select customer
Type choices, press Enter,
1=Select

Opt Customer
Dakley, &nnie O

Barher, Elizabeth &
Farr, George

Weiss, Claus
Coulthard, Phil
Gungabeesoon, Satish
Fair, Jirm 1

Coulter, Simon S
Masri, Maha

Llames, Joe L

o

=

2. Open DDS member in Screen Designer:
a. Locate the DDS display file source named STLCUSTD.
b. Right-click SLTCUSTD and click Open with > Screen Designer on the pop-up menu.
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You have located the DDS source member and opened it with Screen Designer.
Lesson checkpoint

You learned the following:
* How to open the WebFacing perspective
* How to open Screen Designer

Applying Web Settings

Screen Designer view should be open displaying contents of SLTCUSTD DSPF. In this section the Web
Settings view will be used to implement a series of changes.

1. Change CUSTOMER subfile cells to hyperlinks:
a. Select the CUSTSFL record in Screen Designer .
b. Select the CUSTOMER field in Screen Designer .

C. Locate the Web Settings tab and select it. Notice that the view reflects the selection made in
Screen Designer.

40 Web-enable a 5250 application using the IBM WebFacing Tool



v—

w Screen design controls

Screens Screen  Records
Mew | DILIrARAY
SCREEHL SLTCUST
Delete
CUSTCTL
warning: This kechnology preview is not to be used in a production %
CUSTSFL - CUSTOMER
[ B B0 e el e

CLSTOMER,

10

Magnification: .ﬂ i | 1o0e
i
Design Sourcllfe | Preview |

i s
Thumbnails|$tyles|C-:Ic-rs|Links|5ervers|Cc-nsnIe i Web Settings £3| . Search | Co

-= (@ CUSTOMER |
fol@d appearance
|3 Dynamic key labels
|@]  HTML averrides
|3 Hyperlink
@ Image
@] Location

d. Select Hyperlink from the list and set as follows. At conversion time this causes CUSTOMER cells
in the subfile to be rendered as links. At run time when a link is clicked cursor is positioned on
corresponding OPT field, its value is set to '1’, and the ENTER action is performed.
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e. Select Location from the list. Select Change position, select CSS position and change column from
5 to 1. This causes the CUSTOMER subfile column to be shifted four spaces to the left.
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2. Hide OPT subfile cells, and modify subfile header string to match:
a. Select the OPT field in record CUSTSFL from the Outline view.
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b. Notice that selection is reflected in Web Settings view. From the Web Settings view select
Appearance from the list, and Hidden from the resulting pane.
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c. Next you need to hide the heading for the now hidden OPT subfile column. Select the "Opt
Customer’ field in CUSTCTL record from Outline view.
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And set the Web Setting for this field as follows. This will cause the first four characters in the
field to not be shown.
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3. Re arrange top three lines in CUSTCTL record:

a. Select CUSTCTL record then select “1=Select’ field from Screen Designer. In Web Settings view
select Appearance from list and then Hidden. This will cause “1=Select’ field to not be shown.
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b. Repeat for field ‘'Type choices, press Enter’ in CUSTCTL record.
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c. Finally select field "To select customer” in CUSTCTL record. And from the Web Settings view
override field value to "Click on link to select customer’ as shown below.
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4. Close Screen Designer session and re-convert the DDS member:
a. Click the X button in the Screen Designer tab.
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b. Click Yes to save, when asked to do so.

You return to the WebFacing perspective in the workbench.
c. Locate and right click SLTCUSTD DDS object in WebFacing Projects view. Select Convert.
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Only this member will be converted. A conversion report opens after the conversion is finished.

You return to the WebFacing perspective in the workbench.

You have changed the Customer column to hyperlinks, hidden the option field, changed the appearance
of labels, saved the changes and reconverted the DDS source member.

Lesson checkpoint

You learned the following:

* How to open and close a DDS member in Screen Designer
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* How to apply Web Settings
* About Screen Designer
* Appearance, Hyperlink, Location Web Settings

* How to reconvert changed source
Testing the changed application

Let’s see the new user interface in your application.

To test the changed application:
1. Right-click index.jsp in the WebFacing Projects view.
2. Click Run As > Run on Server on the pop-up menu.

Note: If you did not select the Set server as the project default (do not ask again) check box on the
Run on Server dialog when you selected the server in [‘Showing the index.jsp page” on page 32)
ensure that you select the same server on the dialog now. For example, if you had previously selected
WebSphere V6.1 Server, ensure that you select that server now.

3. Go to the browser pane and click the Launch button.
You will see the first screen of your application. Nothing has changed there.
4. Click the Prompt push button, or press command key F4.

Customer List

Click on link to select customer

Customer
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Coulter, Simon 5
Masri, Maha

Llames, Joe L |

The customer selection window appears and the customer fields are shown as links. Also notice the
changed text and the non-visible option column.

Tip: If the customer selection window is still showing the old option selections, most likely the
browser has cached the page and you need to close the browser window, and restart the application.
This will open a new instance of the browser without cached content.

5. Select a customer from the list by clicking on the link.

6. Go through the same steps as in [‘Reviewing the 5250 order entry application” on page 3| to test the
application.

You have launched a reconverted WebFacing application, prompted for a customer and verified the
changes in the customer selection window.

Lesson checkpoint

You learned the following:
* How to test the customized application
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Module summary

In this module you learned how to change the user interface for the WebFacing application using Web
Settings and Screen Designer.

Next you want to improve the part selection subfile. The Web user interface for selecting a record from
this subfile does not work like a Web application. You have to key 1 into the options column to select a
record; this is how the green screen application works. You want a Web user interface where you can
click on a link to select a part.

You will be guided through the Web Setting capabilities in the LPEX Editor to make the necessary
modifications to the part selection subfile. You will change the second column in the part selection
subfile, which contains the part name, from a simple text output field to a link. When you click on this
new part name link, the correct information your program expects is sent. You might ask what is the
correct information? What is your program expecting? It is expecting a 1 in the subfile options field for
the selected part record. The program will receive the same information after you change the user
interface.

The WebFacing conversion will add logic to the user interface, so that the options field is filled with a 1
and the Enter key event is invoked when the link is pressed. You enhance the user interface and don’t
have to change the application, this sounds pretty impressive doesn't it.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Locate a DDS source member

* Open a DDS source member with Screen Designer

* Create a hyperlink action for the customer field

* Hide the option field

* Hide the option heading for the option field

* Hide the select instruction

* Change the appearance of text

* Close Screen Designer

* Reconvert the DDS source member

* Launch the reconverted WebFacing application

¢ Prompt for a customer

* Verify the changes in the customer selection window

Assessment

* What is Screen Designer?

* What are Web Settings?

* How do you apply Web Settings to customize the Web browser interface using Screen Designer?

Changing the user interface using Web Settings in the LPEX Editor

To enhance the results of the WebFacing Tool, you will use the feature Web Settings in the LPEX Editor.
LPEX Editor is a source editor available in the workbench. It allows you to change certain aspects of the
user interface related to the WebFacing conversion process. The LPEX Editor stores the Web Setting
information as comment lines in the DDS source. When you convert the application using the IBM
WebFacing Tool, these DDS source comment lines are picked up and applied to the new user interface.
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This module teaches you how to change the user interface of your WebFacing application with the LPEX
Editor. In the WebFacing perspective you will learn how to select a DDS source member to work with;
start the LPEX Editor to open this DDS member; work with Web Settings in the LPEX Editor to change
the Web look, and then reconvert the DDS member.

Learning objectives

* Locate a DDS source member

¢ Open a DDS source member with the LPEX Editor
* Create a hyperlink action for the option field

* Hide the option field

* Hide the option heading for the option field

* Hide the select instruction

* Change the appearance of text

* Close the LPEX Editor

* Reconvert the DDS source member

* Launch the reconverted WebFacing application
* Prompt for a part

* Verify the changes in the part selection window

Time required

This module will take approximately 15 minutes.
Opening DDS display file source in the LPEX Editor

Since you will use the WebFacing perspective to invoke the LPEX Editor you start this lesson using the
product in the WebFacing perspective.

Skip this section if the product and WebFacing perspective are already open.
1. To start the product and open the WebFacing perspective (optional):
a. Start the product and open the WebFacing perspective, if it is not up and running already.

b. In the WebFacing perspective, make sure that you are in the WebFacing Projects view and not the
Navigator view.

¢. Expand your project in the WebFacing Projects view by clicking on the plus sign (+) beside the
WebFacing project icon if not already.

Next you open the LPEX Editor.

Note: This lesson is very similar to the previous lesson; you use a different tool to apply the Web
Settings. When you create a WebFacing application and want to customize that WebFacing
application, you can choose the tool you like more for applying Web Settings.

2. To open the LPEX Editor:
a. Locate the DDS display file source named STLPARTD.
b. Right-click SLTPARTD and click Open with > Remote Systems LPEX Editor on the pop-up menu.
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The LPEX Editor loads the DDS member.

You have located the DDS source member and opened it with the LPEX Editor.

Lesson checkpoint

You learned the following:
* How to open the Remote Systems LPEX Editor
* How to open the WebFacing perspective

Applying Web Settings in the LPEX Editor

Next, edit the part selection list so that it appears more Web-like. Therefore, you need to give focus to the

record format named PARTSFL.
1. To create an hyperlink for the option field:

a.

S@ "m0 ao0CT

In the Outline view, expand SLTPARTD.DSPF then expand PARTSFL and then select the IID field
(the part number field). Notice the cursor is positioned on the IID field in the DDS source.

Select the Web Settings tab at the bottom of the workbench.
Scroll down to the list, and select Hyperlink.

Check the Enable hyperlink check box to the right of the list.
Select the Use browser settings radio button.

Select the Perform actions radio button.

Check the Position cursor to field check box.

. From the list under the Position cursor to field check box, select the option field

&{PARTSFL.OPT.REF}.

Select the Set field value to check box and change the value 1 in the field to the right of the check
box.

This indicates that you want a 1 to be entered in the Opt field when the hyperlink is clicked.
Select the More actions check box.

Select the Submit function key radio button.

Select ENTER from the Function key list.
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Just to recap, you specified the following, when the application gets converted with the WebFacing
Tool; the part name cells in the subfile will be generated so they appear as links in the browser
window. At run time, when the link is clicked, a 1 will be placed in the option field. Also, a submit
request will be initiated to generate the equivalent of pressing the Enter key and the cursor will be
positioned in the option field for the selected row.

You have accomplished the basic task, but the user interface now has an option column that
doesn’t belong there since it is not needed with the new link. Also the instructions on the page on

how to select a part are wrong. You want to fix this with Web Settings as well, before you test this
new feature.

Next you hide the option field.

Back in the Outline view, select the option field to indicate that you want to work with it.
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2. To hide the option field:

a. Click the Opt field in the Outline view to select it.
b. On the Web Settings page select Appearance from the list.

c. Click the Hidden radio button.

Thumbnails|5tvles|COI0rs|Links|SErvers "f,',‘ Console| ~— =
= [ opr ~ Visitiliey =
; @ Appeatance ™ visible
! & Hidden
€ Hide characters Fram: I
Tims I
= Skvle
I™ override style class: | wF_default wF field L
1 | [robe =

Now this column in the subfile will

be hidden.

You need to hide the heading for the option field as well. The heading is not in the subfile record;

it is located in the subfile control record. Therefore you need to give focus to a different record

format in the Outline view.

))3 — E

Replace 9 changes

Functions+++++++++
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REFFLD (2TQTY¥ *LTI]
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003000 IFRICE R H

003100 1 o1

003200 PARTCTL

oo3300 1')
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003600
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|

1D

IMAME
STOTY
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3. To hide the option heading Opt:

a. Expand PARTCTL in the Outline view, select the Opt Part Description Qty constant.
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Skyle

I” override style dlass: | wF_default wF field

On the Web Settings page, select Appearance from the list.
Select the Hide characters check box.

Leave 1 in the From field.

Type 3 in the To field.

This hides the heading Opt. Now you need to remove the instructions on the panel that guide the
user to put a 1 into the Opt field to select a specific part.

®oouo

You don’t have to give focus to a different record format since this constant is also located on the
PARTCTL subfile control record format.

4. To hide the select instruction:
a. Select the constant 1=Select in the Outline view.
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b. On the Web Settings page select Apppearance from the list.

c. Click the Hidden radio button.

Now you need to add new instructions for the WebFacing page, so the end user knows to click the

link to select a part.

Note: You can’t just change the 5250 constant because you might still use this screen in a 5250
environment, you have to use Web Settings to apply this change to the Web user interface only.

5. To change the instruction text:

a. Select the instruction constant (Type choices press Enter) on the Outline view.
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On the Web Settings page, select Appearance from the list.

Select the Override field value check box, and type the new text Click on 1ink to select in the
field to the right of the check box.

Now all Web Settings are in place and you can go ahead and save the DDS source and reconvert
this DDS member.

6. To close the LPEX Editor and re-convert the DDS member:
a. Click the X in the SLTPARTD tab in the LPEX Editor.

(@ order oty ot AT TT N, =

b. Click Yes to save, when asked to do so.
You return to the WebFacing perspective in the workbench.
C. Select your project wflabxx in the WebFacing Projects view.

d. Expand the project by clicking on the plus sign (+) in front of its icon, if you can’t see the DDS
folder as part of the project.

e. Expand the DDS folder, if it is not expanded already, to show all members in this folder.
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Only this member will be converted. A conversion report opens after the conversion is finished.

Now you test the new user interface.

f. Select the member SLTPARTD that you just changed.
g. Right-click SLTPARTD member icon.
h. Click Convert on the pop-up menu.

You return to the WebFacing perspective in the workbench.

You have created a hyperlink action for the option field, hidden the option field, the option heading and

the select instruction, changed the appearance of text, closed the LPEX Editor and reconverted the DDS

source member.

Lesson checkpoint

You learned the following:

* How to apply Web Settings in the LPEX Editor to change the Web user interface of the application

Testing the changed application

Let’s see the new user interface in your application.

To test the changed application:

1.

Right-click index.jsp in the WebFacing Projects view.

2. Click Run As > Run on Server on the pop-up menu.

Go to the browser pane and click the Launch button.

You will see the first screen of your application. Nothing has changed there.

4. Click the Prompt push button, or press command key F4.

Web-enable a 5250 application using the IBM WebFacing Tool

Note: If you did not select the Set server as the project default (do not ask again) check box on the
Run on Server dialog when you selected the server in[“Showing the index.jsp page” on page 32
ensure that you select the same server on the dialog now. For example, if you had previously selected
WebSphere V6.1 Server, ensure that you select that server now.
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Order Lntry Application —

Parts Order Entry

Type choices, press Enter.
2=Change

Customer number .. ... . To select customer %
Click on link to select

Customer
Dakley, Annie O
Barber, Elizabeth &
Farr, George
Weiss, Claus
Coulthard, Phil
Gungabeesoon, Satish
Fair, Jirm 1 ~

-« Fr
The customer selection window appears and the customer fields are shown as links. Also notice the
changed text and the non-visible option column.

Tip: If the customer selection window is still showing the old option selections, most likely the
browser has cached the page and you need to close the browser window, and restart the application.
This will open a new instance of the browser without cached content.

5. Select a customer from the list by clicking on the link.
6. Click the Prompt push button on the Parts field.

|»

1Tder o1 Ppacation
Parts Order Entry

E choices, press Enter.,
FChange

Select Part
tormer number ...

tomer name .. .... . Click on link to select
ress ..

e Part Description Qty
L oooool \WEBSPHERE REDBOOK
Part Description 000002 Radio_Controlled_Plane 1,3
000002 Change_Machine

000004 Baseball Tickets 3
000005 Twelve_MNum_Two_Pencils 7
000006 Over Under_Shotgun

000007 Feel_Good_vitamins 3
000008 Cross_Country_ Ski_Set
000009 Rubber Baby_ Buggy_ ‘Wheel
0ooo10 ITSO REDBOOE SG24-2152

4 =

The parts selection window appears and the part fields are shown as links. The instruction text has
changed (click on link to select) and the Opt heading and Opt field are gone.

Tip: If the part selection window is still showing the old option selections, most likely the browser
has cached the page and you need to close the browser window, and restart the application. This will
open a new instance of the browser without cached content.

7. Click the hyperlink and notice that the corresponding part number is set in the Part number field on
the Order Entry panel.

8. Exit the application.
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You have launched a reconverted WebFacing application, prompted for a part and verified the changes in
the part selection window.

Lesson checkpoint

You learned the following:
* How to test the customized application

Module summary

In this module you learned how to change the user interface for the WebFacing application using Web
Settings in the LPEX Editor.

When you tested the changed application, you found that you didn’t like the way the WebFacing Tool
mapped some of the display attributes to colors and text styles available in the browser. You wanted to
change the default WebFacing style rules that determine how certain 5250 parts are displayed in a
browser to give the Web user interface a better look. Now you will make these changes.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Locate a DDS source member

* Open a DDS source member with the LPEX Editor
* Create a hyperlink action for the option field

* Hide the option field

* Hide the option heading for the option field

* Hide the select instruction

¢ Change the appearance of text

¢ Close the LPEX Editor

* Reconvert the DDS source member

* Launch the reconverted WebFacing application

* Prompt for a part

* Verify the changes in the part selection window

Assessment

* What is the LPEX Editor?

* What are Web Settings?

* How do you apply Web Settings to customize the Web browser interface using the LPEX Editor?

Changing the style of the Web user interface

This module teaches you how to change the user interface of your WebFacing application by using the
WebFacing style properties dialog. The style changes are applied on a project level; so all pages in a
project will be displayed with these changes applied. In this module you will change the text color and
font for all highlighted fields. You will also locate the style file where these changes have been stored.

Learning objectives

e Start the Style Properties dialog

* Change the DDS Field Display Attributes
* Locate the cascading style sheet file
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+ Edit the cascading style sheet file
* Check the new styles

Time required

This module will take approximately 5 minutes to complete.

Changing the rules for highlighted fields

You will use the Style Properties dialog in the IBM WebFacing Tool to tailor your Web user interface. You
will change the rules for highlighted fields in the 5250 panels so they appear more visible in the Web user
interface. The style for highlighted fields will be altered so at runtime the text font will be different and a
larger font size will be applied.

To change the rules for highlighted fields:

1. Start the workbench of the product and open the WebFacing perspective, if it is not up and running
already.

= \WebFacing Projects X = O | w
| MCDE T
Mew 3
Jpen
Cpen With F
Aidd
CS" Sty Delete. ..
i Skyle r
-] logo Conwert
Wiew Log
License Setkings. ..
Link \with 4
Run As L4
Debug As 4
Profile As 4
=, Update EAR. Libraries
% Prepare For Deployment
¥ Specify iSeries Web Tools Runtime Configuration ...
Team L4
Compare ‘With r
Restare from Local History..
Migrate 4

2. Right-click the wflabxx project.

3. Click Properties on the pop-up menu.
The WebFacing project properties dialog opens.
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4. Under Style in the left pane of the Properties for wflabxx, click DDS Field Display Attributes.
In the right pane of the Properties for wflabxx, the DDS Field Display Attributes pane opens.

) Propetties for wilabxx [ x|

[=- Conwersion
- Command Key Recognition
- Key Button Labels
- Edit Code Options
- MNUDDS Options
- ML Record Metadata
[=) Fun Tirne
L—__| Project
e Order Enkry Applicatic
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- JZEE
- Command Key Actions

- System Screens
[=)- Stwvle

- DD3 Field Color

8 D03 Field Display Attribut
- Window

- Subfile

- Command Keys

DDS Field Display Attributes

¥ou can cuskomize how each DDS display attribute appears on the Web page by changing the
corresponding item.

Fixed row height: I "I

Alignment Font-size: I 9 | Sample
Default field Fonk: I\p'erdana, Regular, 9 J ‘ Sample
Biinking: | verdan, taic, o || oseare)
Column separatars; I cseparator. gif J

Repeat: IRepeat horizontally j ‘

Position: I j

High intensity: I\p'erdana, Eold, 9 D ‘ DSPATR(HI)
Undetline: I\p'erdana, Regular Undetline, 2 J ‘ DSPATREUL)

Protected I | osereR)

ok I Cancel

5. Click the .. push button to the right of the High intensity field.
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The Font dialog opens.

Font
Fant: Fant ztyle: Size:
Camic Sans MS Eald |
) Century Gothic | |Regular 9 a
—, laic 10 2l cance |
Cowirier 1 J
) Courier Mew Baold Italic 12
g CounierT hai 14
Estrangelo Edessza
fived =l hd
mEffects——————+—1 = Sample
[ Stikeout
[ Underline AaBbszz
Colar:
I- Black - I Script:
IWestem ;I

6. Under the Font list, select Comic Sans MS.
7. Under the Font style list, select Bold.
8. Under Size, select 16.

Tip: Don't try to change the color in this dialog, the color setting doesn’t work, later in this module
you will see how to change the color.

This changes the font size and appearance for parts that have the high intensity attribute active.
9. Click OK on the Font dialog.
10. On the Properties page, click OK.
Let’s check the new style in your application.
11. To check the new style:
a. Right-click index.jsp in the WebFacing Projects view.
b. Click Run As > Run on Server on the pop-up menu.

Note: If you did not select the Set server as the project default (do not ask again) check box on
the Run on Server dialog when you selected the server in [‘Showing the index.jsp page” on page|
ensure that you select the same server on the dialog now. For example, if you had previously
selected WebSphere V6.1 Server, ensure that you select that server now.

c. Go to the browser pane and click the Order Entry link.

Tip: See the different font and font size of some of the text; these are the highlighted areas of
your 5250 screen.

You will see the first screen of your application.
d. Prompt for the customer.

The customer selection screen has highlighted text and this text should show in font Comic Sans
MS and size 16.
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Tip: If the text is still showing the old fonts, most likely the browser has cached the page and
you need to close the browser window, and restart the application. This will bring up a new
instance of the browser without cached content.

Next you see how to directly change WebFacing style classes.

You have started the Style Properties dialog, changed the DDS Field Display Attributes and checked the
new style.

Lesson checkpoint

You learned the following:

* How to start the Style Properties dialog

* How to change the DDS field display attributes
* How to check the changed style

* About style changes

Changing styles directly

Instead of working with properties in the WebFacing project you can also change the styles being applied
directly in the Cascading Style Sheet (.css) file that WebFacing uses. In this lesson you see where this file
is located in the WebFacing Project structure and how to find your way around in this file.

To locate the Cascading Style Sheet file:
1. Click the Navigator tab to switch to the Navigator view.
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2. Locate the apparea.css file in the WebFacing project.
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g ek, gif

g prev.aif
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It is located in the following directory hierarchy: wflabxx\WebContent\webfacing\styles\apparea\
3. Double-click the apparea.css file icon in the Navigator view, to open an editor for this file.

Next you change the WebFacing highlighted style class.

The editor dialog will open and show the style source.
4. Scroll down the source file until you reach the .wf-hi class.
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.wE_ri blue { |
color: §000000;

hackground-color :#ocooff:

i

.uf_hbl {

font-style : italic:

i

Lo oeE |
background-image : url (cseparator
background-repeat : repeat-x;

hackground-position : 0% 120%;
} i
.wf hi
{
font-style:normal;
horder-left-color:black:
font—-family:Comic Sans M3:
horder-top-color:hlack:
font-weightihold;
font-size:lept;
H
SPAN.wf_ul {
text—decoration : underline;

)
F s o
P ——

You'll notice your changes from the previous lesson are applied here. The WebFacing Tool has created
style sheet classes for the different 5250 parts and attribute combinations and stored them here. Each
of the lines starting with a dot is a style class name. The statements inside the braces after the class
name describe the attributes of the class itself. The classes have been given descriptive names. For
example .wf_hi defines how a part that has the high intensity keyword is displayed in the browser
and wf_cs describes the column separator. You can change the display characteristics for any of the
5250 attributes.

Next you change the color attribute of the high intensity class.
5. Position the cursor at the end of the last line of the wf_hi class, before the ending brace (}).

6. Press the Enter key to insert a line.
7. Enter the color attribute you want to use, for example: color: red;

.WE ri hlue { =
color: $000000;
background-color: #$occcoff;
}
wE bl {
font-style @ italic:
i
.wf cs {
background-image : url (cSeparatob
background-repeat : repeat-x;
background-positcion @ 0% 120%; -J

i
wE hi

{

font-style:normal;
horder-left-color:black;
font-family:Comic Sans MI:
horder-top-color:black;
font-weight ihold;

pimiiingie 1 61T 7

SPAM.wE ul {
cext—decoration @ underline:

N -
| | 3
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Tip: Don’t forget the semicolon to delimit the line.
8. Look at the left beside the Style sheet editor.

This feature available in the Style sheet editor allows you to look at the changes you have made to a
class directly in the editor without actually invoking the page and showing in a browser.

Presiew wikh: I <sample html file = j
Omen Wikh | Browse | ok -
Selected Style i

Style of .wl hi

Standard HTML Elements

Text m Body Text in Body
Text m Body Text n Body L

Heading 1 Heading
1

Heading 2 Heading 2

Heading 3 Heading 3

Heading 4 Heading 4 H

9. Save the change by clicking the Save icon in the workbench.

o WebFacing - apparea.css - Webspherd

File Edt Sktyle Source Panes  Prewiew
L="_: "__QI:LQ | b

| Javial EllE =

|$-0-a- |swe

|2 B e =

To see the changed user interface, run the application again.

You have located the cascading style sheet file and edited it.
Lesson checkpoint

You learned the following:

* How to locate the cascading style sheet file and edit it

Testing the changed application

To test the changed WebFacing application:

1. Click the X in the Window bar of any editors or views still open at the right upper hand side of the
workbench to close them all.

Now let’s check the new style attribute in your application.
2. Right-click index.jsp in the WebFacing Projects view or Navigator view in the WebFacing perspective.
3. Click Run As > Run on Server on the pop-up menu.

Note: If you did not select the Set server as the project default (do not ask again) check box on the
Run on Server dialog when you selected the server in [“Showing the index.jsp page” on page 32/
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ensure that you select the same server on the dialog now. For example, if you had previously selected
WebSphere V6.1 Server, ensure that you select that server now.

4. Go to the browser pane and click the Order Entry button.

You will see the first screen of your application. Notice the different color of the text in the
highlighted areas of your Web page. Prompt for the customer. The customer selection screen will
show the same changed attributes; remember style changes are applied to all pages as shown.

rder En pphcation —

@ Order Entry

Type choices, press Enter.
2=Change

Customer number ... .. ..
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Masri, Maha | |
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Fkeyl2=Cancel
Bl _—

You might not have noticed it before, but there is still a command key description at the bottom of
the Customer Selection list window.

You might have guessed it; you will fix this in the next module.
Lesson checkpoint

You learned the following:
* How to test changes

Module summary

In this module you learned how to change the user interface of your WebFacing application by using the
WebFacing style properties dialog and editing the styles directly in the Cascading Style Sheet (.css) file
that WebFacing uses.

In the sample Order Entry application, the Customer Selection list window doesn’t follow the CUA® rules
for command key descriptions. The WebFacing Tool will by default not recognize these command key
descriptions and will not delete them. The Order Entry main screen has a command key enabled that has
no description associated with it. The WebFacing Tool by default doesn’t handle this situation and puts a
default string in the push button label representing this command key. Next you learn how to enable the
WebFacing Tool to deal with these common green-screen environments.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Start the Style Properties dialog
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* Change the DDS Field Display Attributes
* Locate the cascading style sheet file
 Edit the cascading style sheet file

* Test the new styles

Assessment
¢ What kinds of style changes can you make to the Web user interface?
* How do you change the Web user interface using style properties and CSS?

Adding command key rules and labels

Most of the command key descriptions placed at the bottom of the original panels in the sample Order
Entry Application have been removed from the WebFacing user interface. The removal happens
automatically if the command key descriptions follow the Common User interface Access (CUA) rules
(for example, F3=Exit). If they don’t follow these rules you can supply the WebFacing Tool with the
command key description rules you use in your user interface, and the WebFacing Tool will apply these
rules to recognize your specific command key descriptions. One of the record formats in the sample
application contains a command key description that doesn’t follow the CUA rules.

This module teaches you how to use the WebFacing conversion properties dialogs to add your own
command key description rule. Also, you might have enabled command keys without describing them in
the user interface because they are only used for specific functions and your end user knows how they
work. For example, command key 3 for ending an application or command key 12 for canceling a task
are generally well known. Your user interface might not list them explicitly at the bottom of the panel. In
these situations, the WebFacing Tool doesn’t have a string to use as a label for the push buttons on the
Web page, and will use default labels, for example CF12 for command key 12. As an alternative, the
WebFacing Tool allows you to specify labels for common command keys so it can label the command key
push buttons correctly.

Learning objectives

* Start the Properties dialog

* Select Command Key Recognition Patterns
* Add a new command key rule

* Reconvert the DDS members

* Test the applied new rule

* Change the text for the F12 command key
* Reconvert the DDS members

* Test the new command key label

Time required

This module will take approximately 10 minutes to complete.
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Adding a new command key description pattern

The prefix for the command key description in the SLTCUST record format is Fkey=.

Coulthard, Phil
Gungabeesoon, Satish
Fair, Jirn 1

Coulter, Simon S
Masri, Maha

Llarnes, Jog L

keylZ=Cancel

This doesn’t follow the CUA rules normally used in i5/0OS user interfaces, so the WebFacing conversion
does not recognize this pattern and does not hide it. You have to add this prefix pattern to the WebFacing
Tool conversion rules in the WebFacing Properties dialog.

To add a new command key description pattern to WebFacing conversion rules:
1. In the WebFacing Projects view, right-click your WebFacing project wflabxx.
2. Click Properties on the pop-up menu.

Navigat0r| - El 22

el

b

open

Gpen With e
Add

e

Style 4
Canvett

View Log

License Setkings...

Linik. WWith 4
Run As r
Debug As 4
Profile As 4

=, Update EAR Libraries

% Prepare for Deplovment

¥ specify iSeries Web Tools Runtime Configuration ...
Team 3
Compare \With 4
Restare from Local Hiskory...
Migrate 4

o TN

The Properties for wflabxx dialog opens.

o Propetties for wflabxx

= Conwersion

- Carrand Key Recognition
Key Button Labels

Edit Code Options
MHUDDS Options

- ¥ML Record Metadata

3. In the left pane of the Properties for wflabxx, under Conversion, select Command Key Recognition
Patterns.
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o

The right pane will switch to Command Key Recognition Patterns.

Command Key Recognition Patterns

Cormand keys will be displayved as buttons in wour Web application, ‘You can identify the text on these
buttons by specifying recognition patterns,

WebFacing parses the text constants on each screen to identify the Four-part recognition patterns:
=prefix=<key number = <separator > <text string=. Then it labels each command key button in wour
web application with the detected text string., Many applications use anly one recognition pattern.

Example
A green-screen application that uses the prefix "F" and the sei}\fator

BRI G = becomes

Select or type the prefixes (such as CA ar PF) and separator (such as = ar i) thak appear on waour green

screens, Add them ko the table below,

Separataor: |_= =] l Add I
Prefix | Separakor | Bk |
CF

can be coneerted like this:

Prefix:

Fhey = Mave Up |
ChA =
F -

Mave Dovwn |

Select an option ko handle the detected kext string For the command keyvs shown in the application area:

% Remove best
¢ Keep text
" Replace text with button for all records

" Replace text with button For window records

In the Prefix list, type Fkey

In the Separator list, leave =

Click Add to the right of these two lists.

The additional rule is now part of this style.

Click OK.

Next, you will test this feature by converting the DDS member and running the application.

Since these are conversion properties you are changing and not style properties as in the previous
module, you will need to reconvert all members that contain command key descriptions with this
pattern. In the sample Order Entry application this is only member SLTCUSTD.

To reconvert DDS members:

a. In the workbench in the WebFacing Project view, expand the wflabxx project, if not already
expanded.

b. Expand the DDS folder, if not already expanded.
Right-click the SLTCUSTD member icon.
d. Click Convert on the pop-up menu.
After the conversion, take a look at the change.
Let’s see how the new rule is applied to your WebFacing application.
To test the applied new rule:
a. Right-click index.jsp in the WebFacing Projects view.
b. Click Run As > Run on Server on the pop-up menu.

Note: If you did not select the Set server as the project default (do not ask again) check box on
the Run on Server dialog when you selected the server in [‘Showing the index.jsp page” on page|
ensure that you select the same server on the dialog now. For example, if you had previously
selected WebSphere V6.1 Server, ensure that you select that server now.

c. Go to the browser pane and click the Order Entry link.

You will see the first screen of the sample application.
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d. Click Prompt or press F4.
The Customer Selection list window opens.

Parts Order Entry

Type choices, press Enter.
el o

Customer number .. ... ..

To select custo

Click on link to select

Customer

Dakley, Annie O
Barber Elizabeth
Earr, George
Weiss, Claus
Coulthard, Phil
Gungabeesoon, 5
Fair, Jirm 1
Coulter, Simon S

Masri, Maha ||

Llames Joe L

S—_

Note: Notice that the command key text Fkeyl2=Cancel is gone from the bottom of the window.

e. If the push button still shows, restart the Application server.

Now that you know how to change the command key recognition patterns in the WebFacing Tool, you
can add text to frequently used command keys that don’t have a text description in the DDS source.

Back on the Order Entry panel, you can see that the push button for F12 does not have a description and
is labelled F12. You will learn how to change this in the next lesson.

You have started the Properties dialog, selected Command Key Recognition Patterns, added a new
command key rule, reconverted the DDS members, and tested the applied rule.

Lesson checkpoint

You learned the following:
e About conversion rules
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* How to add a new command key description pattern
* How to reconvert and test the applied new rule

Adding key button labels

The WebFacing Tool allows you to specify command key descriptions for command keys that are
commonly used in your application but not described in your DDS source and on your screens. This way
the push button labels on the Web pages can automatically be changed during conversion to the correct
text. You will add the description Cancel to the WebFacing conversion properties so the push button will
get created to show a Cancel label instead of F12.

To add key button labels:
1. Right-click your WebFacing project wflabxx.

Navigat0r| = El b,

Preisim |.'|

Mew L4

Open
Cipen With F

Add
Delete. .
Style r

Carvett

Wiew Log

License Setbings...

Link WWith 4
Run As L4
Debug As 4
Profile As L4

=, Update EAR Libraries

% Prepare for Deplovment

_§’ Specify iSeries Web Tools Runtime Configuration ...
Team k
Caompare With r
Restare from Local History...

Migrate 4

2. Click Properties on the pop-up menu.

The Properties for wflabxx dialog opens.
3. In the left pane of this dialog, under Conversion select Key Button Labels.
In the right pane of this dialog, the Button Labels opens.
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o) Properties For wilabxx

[=)- Canversion

= 3ty

- Command Key Recognition
- ey Button Labels

- Edit Code Options

- MMIUDDS Cptions

- ¥ML Fecord Mekadata

=1+ Run Time

Project
‘o Order Entry Applicatic

- DD5 Object Mappings
- LUIM Object Mappings
- Command Key Actions
- System Screens

1=

- DD Field Color

- DD Field Display Attribut:
- Window

- Subfile

- Command Keys

Key Button Labels

This page allows vou to modify the label of key buttons displaved in your WebFacing application.

Select the key and the button label you want to use, and add it to the table below,

Ky i EButton label: Cancel j fAdd
Ke | Button label |
F1z Cancel

Delete

Mowe Up

Ml

Move Do

L

Cancel

Under the Key list, select F12.

Under the Button label list, select Cancel.
Click Add to the right of these two lists.

The additional label is now part of the WebFacing conversion properties for this WebFacing project.
Click OK at the bottom of the Properties dialog.
Next, back in the workbench, convert the changed application.

To convert the application in the workbench:
a.

b
C.
d

Expand the wflabxx project if not already.
Expand the DDS folder if not already.
Right-click the ORDENTD member icon.

Click Convert on the pop-up menu.

After the conversion, take a look at the change.

Let’s see the new label for the F12 push button in your WebFacing application.

To test the new label:

a. Right-click index.jsp in the WebFacing Projects view.

b. Click Run As > Run on Server on the pop-up menu.

Note: If you did not select the Set server as the project default (do not ask again) check box on
the Run on Server dialog when you selected the server in|“Showing the index.jsp page” on page|
ensure that you select the same server on the dialog now. For example, if you had previously
selected WebSphere V6.1 Server, ensure that you select that server now.
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Order Enﬁ !ppl!ez

BEnter Type chaices, press Enter,
BExit 2=Change
EPrompt
Customer number .. ... .. ||
mHELP

4 |
c. Go to the browser pane and click the Order Entry button.

d. Check that the Cancel push button on the first page now shows the correct label as shown.
e. If the push button still has the old text, restart the Application server.

1) Click the Servers tab at the top view in the workbench.

2) Right-click the server icon.

3) Click Restart > Start on the pop-up menu.

Thumbnails|Styles|C0|ors|Links W\Web Settings|C0nsole| e (0

SEerver | Skatus | Skake |
. webSphere Application Server v6.0
Al WwebSphere Applicabion Sepuer v

ew 3
Open
Initislize Server Status

Synchronized

Delete

W Detug
@ start
o Profile
Restart
Stop
{5 Publish

5 Profile

4) Run the application again.

You have changed the text for the F12 command key, reconverted the DDS members and tested the
command key label.

Lesson checkpoint

You learned the following:
* How the change the text for a command key in the user interface

* How to reconvert and test the changed application

Module summary

In this module you learned how to use the WebFacing conversion properties dialogs to add your own
command key description rules and labels.

Now that you have a Web user interface where the green screen doesn’t show through as much as after
the first WebFacing conversion you did in [“Converting selected source members” on page 27 you want
to add some more refinements to the appearance of your Web pages.
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Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Start the Properties dialog

* Select Command Key Recognition Patterns

* Add a new command key rule

* Reconvert the DDS members

* Test the applied new rule

¢ Change the text for the F12 command key

* Reconvert the DDS members

* Test the new command key label

Assessment

* What is the Style Properties dialog?

* How do you change command key recognition patterns?
* How do you add a new command key rule?

* How do you change the text of a command key?

* How do you reconvert and test these changes?

Working with more style properties

This module teaches you how to change the user interface further, using style properties. You will learn
to work with WebFacing Tool style properties and check the changes by refreshing the style and running
the application.

Learning objectives

e Start the Properties dialog

* Change the window style

* Change the subfile style

¢ Change the command key style
* Test the changed properties

Since a style is used on a project level, all Web pages in your project will contain the changes you apply
to a particular style.

Time required

This module will take approximately 10 minutes to complete.
Starting the WebFacing properties style dialog

First, you will use the WebFacing Style properties dialog to tailor your Web user interface. You will apply
changes to the window layout of your screens, the subfile appearance, and the command key push
buttons.

To start the WebFacing properties dialog:
1. In the WebFacing Projects view, select the wflabxx project.
2. Right-click the wflabxx project, and click Properties on the pop-up menu.
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WMavigatod = Ell 5| apparea.

Previr with

Mew 3
Jpen
Dpen With F
fiddd
Delete...
Skyle 4
Convert
Wiew Log
License Setkings. ..
Link, \with 4
Run As 4
Debug As 4
Profile As »
= Update EAR Libraries
% Prepate For Deployment
& Specify iSeries Web Tools Runtime Configurakion ...
Team 4
Compare ‘With 4
Restore From Local History. ..
Migrate 4

Properties

The Properties dialog opens.
3. Under Style in the left pane of the Properties dialog, select Window.
The right pane of the Properties dialog shows the Window properties.

‘ o Properties for wilabxx [x]

I
| = Conversion Window
| - Command Key Recognitiorn

- Key Button Labels

A window is displaved in the application area to represent a DDS WINDOW record. You can customize

- Edit Code Options the appearance of the window title, body and the colar of the window shadow,
- MNIUDDS Optiaons
XML Record Metadata  Window areas: | - |
(=l Run Time: _
& Project Fareground
| ovder Eniry bl | o | |
| - DS Ohject Mappings
l - LI Objedt Mappings Font: ICDmic Sans M3, Bold, 16 J
| - JZEE
- Command Key Actions
- Qysbem Screens ~EBackground
[=- Style
- DD Field Color Color: — J
| - DS Field Display Attribut ; . Body
| - Window e | J
' - Subfile
- Zommand Keys Pzpzat I j
Positian: I j

=]

Border colar: I

wlEe e

@ Ok I Cancel

4. Select Title from the Window areas list.
5. Under Foreground click the .. push button to the right of the Color field.
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6. On the Color Chooser dialog, click red.
7. Then click OK in the Color Chooser dialog.
The Window Properties page reappears.
8. Click the .. push button to the right of the Font field.
9. Select font Comic Sans MS, size 16.
10. Click OK on the Font dialog.
11. Under Background, click the .. push button to the right of the Color field.
12. On the Color Chooser dialog, click green.
13. Click OK on the Color Chooser dialog.
The Windows properties dialog reappears.
14. Select Body in the Window areas list at the top of the page.

Windowr

A window is displayed in the application area to represent a DDS WINDOW record. You can customize
the appearance of the window title, body and the color of the window shadow.

Window areas: IBody i vI

r— Foreground

D T

Fant: Iw‘erdana, Regular, & J
r— Background
Colar: I J
Body
Image: I J
Repeat: I j
Paosition: I j

Rorder color: —] Iy

15. In the Border color field at the bottom of the page click the .. push button to the right of the Border
color field.

The Color Chooser dialog opens.
16. Click blue.
17. Click OK in the Color Chooser dialog.

You have started the Properties dialog and changed the window style.
Lesson checkpoint

You learned the following:
* How to start the Properties dialog and change the window style

Changing the appearance of the subfile

To change the appearance of the subfile:
1. Back in the Properties dialog, under Style, select Subfile.
The Subfile properties page opens on the right pane of the dialog.
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Subfile

The scrall bar is used to view subfile records in the converted Web page, Select background colors
and images ko be used for the scroll bar elements and the subfile records.

Subfile areas: ISubFiIe record - odd row l > |I

 Background

Calar I D ;I

Image: | 2dd row

Repeak: I 'l
Fosition: I j

Ewen row F
Hl

2. Select Subfile record - odd row in the Subfile areas list.

3. Under Background, click the .. push button to the right of the Color field.
The Color Chooser dialog opens.

4. Click light yellow.

€ Color Chooser |

et | FF |FF |33
r Transparent

oK | Carcel |

Tip: If you are interested in the hex value of certain colors as they are used in the style classes, the
Color Chooser dialog displays the hex values; see the value "FFFE33".

5. Click OK in the Color Chooser dialog.
You return to the Properties dialog.
6. Select Subfile record - even row in the Subfile areas list at the top of the page.

Subfile

The scrall bar is used ko view subfile records in the converted Web page, Select backaround caolars
and images to be used for the scroll bar elements and the subfile records,

=0y (FRET=ECH | S UbFile record - even row

—Background

Calor: I D ;I

Odd row

Image: I

Repeak: I "l
Position: I j

Even row

KR |
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7. Under Background, click the .. push button to the right of the Color field.

The Color Chooser dialog opens.

8. Click green.

9. Click OK on the Color Chooser dialog.
Now at runtime the odd and even records will be displayed with different background colors. Next

you will customize the appearance of the command key push buttons.

You have changed the subfile style.
Lesson checkpoint

You learned the following:
* How to change the subfile style

Customizing the appearance of command keys

To customize the appearance of command keys:

1. In the left pane of the Properties dialog under Style, select Command keys.

The Command Keys properties opens on the right pane of the dialog.

3.

Command Keys

This page allows vyou ko madify the style of all cormmand key butkons displayed in vour WebFacing
application,

Command key states:  |Default

r Foreground
= Raollover

Button down

Colar:

&

Font: I'u'erclanaJ Regular, 10

Text indent in pixels: I 12

Text align: ILeFt j - Default ‘
Wertical align: Inbove kext j
Rollover ‘
r~ Background ‘
Colaor: I

Imag2: | pyeon_up.gif

Repeak: INn repeak

il | |

Position: I

Change the Foreground color for all three states of the buttons:
* Default

* Rollover

* Button down

Now you have finished customization.

Click OK on the Properties dialog.

You have changed the command key style.

Lesson checkpoint

You learned the following:

* How to change the command key style
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Checking the new style
Let’s see the new look of your application.

To check the new style:
1. Right-click index.jsp.

2. Click Run As > Run on Server on the pop-up menu.

Note: If you did not select the Set server as the project default (do not ask again) check box on the
Run on Server dialog when you selected the server in [“Showing the index.jsp page” on page 32/
ensure that you select the same server on the dialog now. For example, if you had previously selected
WebSphere V6.1 Server, ensure that you select that server now.

3. Run the application.
4. Click Prompt.

|»

rder En pplication
Parts Order Entry

Enter Type choices, press Enter,
B Cancel '{T} 2=Change

EHELE Customer number . ... ...

To select custo
Click on link to select

Customer
Oakley, Annie O

Farr, Gearge

Coulthard, Phil

Fair, Jirn ]

Masri, Maha

=
4| | »

The application window shows different colors, and the subfile records are colored. The command
key push buttons change color, depending on their state.

Tip: If the text is still showing the old colors, most likely the browser has cached the page and you
need to close the browser window, and restart the application. This will open a new instance of the
browser without cached content.

You have tested the changed properties.
Lesson checkpoint

You learned the following:
* How to check the new style

Module summary

You have tested your WebFacing application with updated style properties and now you want to
customize the style further by updating the look and feel for a fictional company.
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Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Start the Properties dialog

* Change the window style

* Change the subfile style

¢ Change the command key style

* Test the changed properties

Assessment

* What is the Properties dialog?

* How do you change the window style, subfile style and command key style?
* How do you check the changed style?

Customizing the default style

Rational® Application Developer contains editors for HTML and Cascading Style Sheet (CSS) files. When
you created the WebFacing Web project, you selected a default style to your Web-enabled application.

This module teaches you how to customize that style, updating the look and feel for a fictional company.
You will change the color of the application and add a company logo as shown below.

F ‘Web Browser

PageEuilder. jsp B whlabx: Log | 5| gradient.css

Ihttp:,l',l'IUcthDst:QDSU,I'WFIabxx,I'webFacing,l'WebFacing.do j = | e o~ (O = Qéh |

MAIN MENU

Type choices, press Enter,
Z=Change

Customer number .. .. ... ||

Done
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Learning objectives

* Locate the existing style

* View the design of the existing style

* Import the company logo

* Edit the style sheet to include the company logo

* Edit PageBuilder.jsp to remove and resize fields for your logo
* Change the color

Time required

This module will take approximately 15 minutes to complete.
Opening Pagebuilder.jsp

First you open the JSP file called PageBuilder as you want to edit this file to add a new company logo in
a follow-on lesson. PageBuilder.jsp is the main JSP for the WebFacing project.

To open the PageBuilder.jsp:

1. Open the product in the WebFacing perspective, if it is not already open.

2. Expand wflabxx > Style > gradient > chrome > html in the WebFacing Projects view.
3. Open PageBuilder.jsp by double-clicking the file.

4. Click the Design tab to see the existing style, shown below.

o WebFacing - PageBuilder.jsp - Websphere Development Studio Client Advanced Edition for iSeris
File Edt Display Insert JSP Format Table Frame Page Tools Mavigate Search  Project  Data

| W | g | & |«
[Jria EERE e ey e e |
[#-0 4 - |85 - |c|®3e|5- @ -01-£ G-
| 8 a a0 s
[ WebFacing Projects 23 Navigator| T = 8 — O
P UM Help d | body - | Standard ~
N Stvle i =
% ' ] -
5 G sppures s e R
E[Eb chrome - . L 3)3;[
8] gradient.css ; ;
; jheader.gif 5 u .................................
header_end. gif T SrerrrrerrrreTrIIITIC :
- html [ :
o [ Cmdkevs.jsp b
~[&] PageBuilder.jsp - : :
cE e

=l Properties 53 Gallery|WebFaci... | ~ =

=
biody Style: Propetties: I:II:

_I;I
« Skyles 1] | L4

Text Background: Image: Design Sc-urce|F‘review|
You will now change the style to reflect a fictitious XYZ Company.

You have seen the design of the existing style.
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Lesson checkpoint

You learned the following:
* About PageBuilder

* How to open a JSP file called PageBuilder

Importing the company logo

The first step is to import the company logo.

To import the company logo:

1. Select chrome in the WebFacing Projects view, then click File > Import from the workbench menu.

Expand General then click File System

o K~

in the Import wizard, and click Next.

On the next page of the wizard, click Browse and go to the C:\WFDEMO folder and click OK.
Select the check box next to sample_header.gif in the right list.

xx is replaced by your unique team number.

ﬁ) Import

File system

Import resources from the local file system,

From directory: I CWFDEMO

j Browse, . |

[H (= WFDEMO

Filker Tvpes. .. | Select All Deselect Al

2] codesnippetExa.txt
ﬁsample_header.gif
O E’window.gif

Into folder; I wlab:cxwebContent/webFacing)'stvies/chrome

Opkions
[ overwrice existing resources without warning
" Create complete Folder structure

{* Create selecked folders anly

< Back

[ExE = | Finish I

Cancel

6. Click Finish.
You have imported the company logo.
Lesson checkpoint

You learned the following:

* How to import the company logo
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Editing the style sheet and PageBuilder.jsp

You must now edit the style sheet to configure the header to include the company logo that you just
imported. Then you edit PageBuilder.jsp to resize the table to add the new company logo. Finally you
make further changes to the style sheet to remove existing images (side_curve.gif and side.gif) and to
change the color of these areas of your application.

To edit the style sheet and then PageBuilder.jsp:

1. Expand wflabxx > Style > gradient > chrome in the WebFacing Projects view, right-click gradient.css
and click Open from the pop-up menu.

In the Styles view, double-click .headc to edit that style.

Thumbnails Colors | Links | Servers | Web Settings | Console | &

%%'“S%'”@?_SZ:V

Mame

| Description

| Media |

1 BODY

Gf} thesidecurve
ET} theside

Q} thesidebottan
‘ .headc

q} headr

q} theapp
‘T} Jaunchbutton

Page properties

Select *Background.

field to Left as shown.

Update the Image field to sample_header.gif, change the Repeat field to No repeat and the Left

& set Style Properties —— .headc H=] E3
= *Fant Background
i Font styles
& *Eiackground
= Colar
- #Text Layout e || j /l
[=)- Layaout .
5----Margin Image : Isample_header.gif L |
i Border Color Repeat : IND Fepiat j
i~ Barder Style
i~ Border Width #Atkachment I j
* Padding
Left : ;
&= Pasition II‘BFt El IPmEl -
Floating Top ! ITUD j IF‘ier j
- Clipping
- Lisk
- Cthers
)] oK I Cancel Apply

5. Click OK.
6. Save gradient.css by pressing CTRL-S.
7. Now you must edit PageBuilderjsp.
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8.

10.
11.

12.

13.
14.

Click the PageBuilder.jsp tab. Then go to the Source tab.

@ PageBuilder.jsp. X S| gradient.css | f] index.jsp | - =

PageBuilder.jsp ~

The next line load the style sheet which will giwve this pac
The prefix scriptlet to the href part of the tag will reso!
nate .

The first line i= used by the editor and is comwented out :
WA
<ESF 5
<link rel="stylesheet" type="text/cs3" href="gradient.css":>
<E T
<link rel="stylesheet™ type="text/css" href="styles/chrome/

<HMETL name="GENERATOR'" content="IEM WebZphere Studio™:>

</ head:>

<table id="<3=(Jtring)session.getittribuce ("Unigueld™) > Tak
height="100%" width="1024":>
<thody:>
<Lr>

<td class=headc colspan=6 rowspan=1 widtch="100%"
R A
From the request retrieve a text string
g

<H/F B

<titler<%=regquest.getittribute ("ApplicationTitle™)s></titles—

{%=request.getAttributet"ApplicationTitle"]3'

‘ | o

Design | Source | Preview |

Change the table height to 100 and width to 1024.
Delete the first <td>...</td>.

Change: <td class=headc colspan=4 rowspan=1 width="441" height="33"> to:
<td class=headc colspan=6 rowspan=1 width="100%" height="100">

Delete the next <td>...</td>.

This removes the extra fields in the table and resizes the remaining ones for your logo.

Your code should now look like this:

<table id="<%=(String)session.getAttribute("Uniqueld")%> Table"
border="0" cellspacing="0"
cellpadding="0" frame="box" height="100" width="1024">
<tbody>
<tr>

<td class=headc colspan=6 rowspan=1 width="100%" height="100">

<%=request.getAttribute("ApplicationTitle")%>
</td>

Save PageBuilder.jsp
Click the Design tab.
It should look as shown below:
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15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.

84

o WebFacing - PageBuilder.jsp - Websphere Development Studio Client Adyanced Edition f

File Edit Display Insert JSP Format Table Frame Page Tools Mavigate Search  Project
| ™ | [
| Eoze £ [a-5- 0 |B[5-A-
|$-0-Q- | EH#G-|B|OFL[B-]0 -3 -0
|| e & D&

™ WebFacing Projects &3 Navigator| =

&

B Stvle ﬂ = | 2 & Standard -

"-CS gradient =
e =
E|[Eb chrome

8| gradient.css E
: gheader_end.gif E
== himl

[ cmdkeys.dsp
E PageEuilder . jsp

. B Sl
F : .......................
= Properties &2 GaIIery|WebFaci... | = : :

EI =
body Style: Properties: @
table
e, Alignment:  Horizonkal: | (Auka) ;
[E i Background: Color: -

* Shyles 4| | N
td i i
Design SDurce|Prewew| -

Now update the color of the side by selecting the gradient.css tab again.
In the Styles view, double-click .thesidecurve.

Select *Background.

Remove side_curve.gif from the Image field, leaving it blank.

From the drop-down list next to the Color field, select the color Gray.
Click OK again to update the Style property.

Open .theside style from the Styles view.

Remove side.gif from the Image field, leaving it blank.

From the drop-down list next to the Color field, select the color Blue.
Click OK again to update the property.

Save gradient.css by pressing CTRL-S .
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26. Run the wflabxx application on the test server to see the new style, shown below:
]

PageBuilder . jsp . yweh Browser X

= wlabx: Log | 5 gradient.css

Ihttp:,l',l'IUcthDst:QDSU,I'WFIabxx,I'webFacing,l'WebFacing.do j = | L g = Qéh | ﬁ

MAIN MENU

Type choices, press Enter,
Z=Change

Customer number .. .. ... ||

| o

Done

You will now update another style sheet to make changes to the buttons and text.

You have edited the style sheet to include the company logo and edited PageBuilder.jsp to remove and
resize fields for your logo.

Lesson checkpoint

You learned the following:

¢ How to edit the style sheet to configure the header to include a company logo
Module summary

You have customized the default style to update the look and feel for a fictional company. Now you need
to move the application into production and you need the WebFacing application to prompt the users for
signon information when it starts.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Locate the existing style

* View the design of the existing style

 Edit the style sheet to include the company logo
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+ Edit PageBuilderjsp to remove and resize fields for your logo
* Change the color

Assessment

* What is PageBuilder?

* How do you view an existing style?

* How do you add a company logo to an existing Web page?

Adding authentication

This module teaches you how to secure your application by forcing authentication before the application
is invoked.

Learning objectives

* Start the Properties dialog

* Open the project run-time properties

* Change the signon properties for the order entry application
* Test the signon dialog appears

Time required

This module should take approximately 5 minutes to complete.

Removing the default user ID and password

You will use the CL command properties page of the runtime to remove the default user ID and
password information.

In the WebFacing perspective in the WebFacing Projects view:
1. Right-click wflabxx project.
2. Click Properties on the pop-up menu.
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Navigatc-r| = E|| & Pagebuilder.jsp £3

beon

Tew L4
Dpen
Open With e
fdd
Delete. .
Skyle L4
Conwverk
Wiew Log
License Setkings...
N —— Lirk. 'ith k
= Properties &
Run As 3
Debug As 4
Property Profile As L
Cache job de &= Lipdate EAR Libraries
Change expil % Prepare for Deployment
Convert ko u
Errar detail ke &’ Specify iSeries Web Tools Runtime Configuration ...
Figld exit key ~ Team L4
Force DFRW Compare With L4
Hast Restare From Local Histary. .,
Host pork Migrate »
Include comn

Tnaert mnde
4]

The Properties for wflabxx dialog opens.

3. Under Run Time in the left pane of the Properties dialog, select Order Entry Application.

The Order Entry application properties pane opens.

@ rroperties for wilabax x|

[=]- Comversion call ordentr
- Command Key Fecognition
- Key Button Labels
- Edit Code Options Cormand label: I call ardentr

- MNUDDS Opkions

- D35 Object Mappings

CL command: | CALL ORDEMTR.
- %ML Record Metadata
=- R:U” Time Inwocation name: | InYW1
=]~ Project
..... call ordentr verride project settings For this command

—Settings specified For this CL command:

- Command Kews

- UIM Object Mappings
- JZEE Hosk name: I TORASISE Haost part: I 4004
- Command Key Actions
- System Screens peciFy 5005 signon values
Bl Style i [Iserid; I
- DD3 Field Color
- DDS Field Display Atkribub Password% I
- Window
- Subfile Confitm password; |

¥ Handle as if DDS files are compiled with DFRWRT{*YES) option

™ Use insert mode For kevboard text entry

(414 | Cancel |

4. Make sure the Override project settings for this command check box is selected.

5. Clear the Specify i5/0S signon values check box.
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6. Click OK at the bottom of the Properties dialog.

You are back in the WebFacing Projects view. You have changed the authentication behavior for this
link (application). In this WebFacing project you only have one link, but imagine that you have
multiple entry points into your application like a menu. You could specify a different authentication
behavior for each of these links. On the other hand, if you have multiple links in a WebFacing project
and the authentication should be the same for each different link, then you can specify an
authentication rule on the project level. To do this, just go to the project properties page instead of the
CL command properties page and specify the desired authentication behavior there.

You have started the Properties dialog, opened the project run-time properties and changed the signon
properties for the order entry application.

Lesson checkpoint

You learned the following:

e About authentication

¢ How to add signon properties to the WebFacing order entry application

Testing the authentication dialog

As before, you run your application in the WebSphere Application Server Test Environment.

To test the authentication dialog:

1.
2.

Right-click index.jsp.

Click Run As > Run on Server on the pop-up menu.

Note: If you did not select the Set server as the project default (do not ask again) check box on the
Run on Server dialog when you selected the server in [“Showing the index.jsp page” on page 32/
ensure that you select the same server on the dialog now. For example, if you had previously selected
WebSphere V6.1 Server, ensure that you select that server now.

Click the Launch button.

You will see the authentication dialog.

] PageBuilder.jsp | & gradient.css @

<0 [ Q§° |http:,I',I'Incalhnst:QDBDIWFIabxxIWFInvncaticj =

=4

Please type your user name and password,

User Name: ||
Password: I

B| ogon @ Cancel

Specify your User Name and Password.
Click the Logon push button on the Authentication dialog.

The application will run like before, if the job environment for the user ID you specified is setup
correct for this application.

If the LOGON dialog doesn’t appear, restart the Application server.
a. Click the Servers tab at the top view in the workbench.
b. Right-click the server icon.
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c. Click Restart > Start on the pop-up menu.
d. Run the application again.

You have tested that the signon dialog appears.
Lesson checkpoint

You learned the following:

* How to test authentication for the WebFacing application

Module summary

You have added authentication to the WebFacing application and now want to enhance the look of the
index.jsp page to give the start page of this application a professional appearance. The workbench
contains several tools to design and enhance Web pages. Also with the workbench you have access to
sample pictures, icons, animations, and more. You will use some of these tools and samples and enhance
the page so it becomes more attractive.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
e Start the Properties dialog

* Open the project run-time properties

* Change the signon properties for the order entry application

¢ Test the signon dialog appears

Assessment

* What is authentication?

* How do you add authentication to a WebFacing application?

* How do you test that authentication works in the WebFacing application?

Enhancing index.jsp page

This module teaches you how to use the Web tools in the workbench to update the index jsp file. The
index.jsp file created by the IBM WebFacing Tool that allows you to start your WebFacing application is
plain. In this module you will add some color to it, as well as some pictures to make it a more interesting
Web page.
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Learning objectives

* Open the application start page (index.jsp) in Page Designer
* Change the window title to Order Entry

* Add a style to the Order Entry Web page

* Insert a heading

e Add a picture to the Order Entry Web page

* Add a marquee to the Order Entry Web page

* Change the color of the window title

* Remove default text added by the WebFacing Tool

Time required

This module should take approximately 20 minutes to complete.
Opening Page Designer
First you need to open the start page of the application in Page Designer.

To open Page Designer:
1. Open the WebFacing perspective, if not already open.
You should now have the WebFacing Projects view in your workbench environment.

#= ‘WwebFacing Projects x

B fﬁ wiflabie
[-a L Commands

s400a=WFLAE XX /QDDSSRC(ORDI
=400a=WFLAE XY /ODDSSRC(SLTC
o <s400a=WFLAE: /QDDSSRCSLTP
r:? M Help

CS’ Skyle

; @ index.jsp

“[&] logon.jsp Mew 4
Open% 3
iew Log

License Setkings. ..

2. Expand the wflabxx WebFacing project.

w

Right-click the index.jsp icon.
4. Click Open on the pop-up menu.

The Page Designer opens in the upper right pane of the workbench and shows the index.jsp page as
the WebFacing Tool created it.
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5.

You have opened the application start page (index.jsp) in Page Designer.

PageBuilder.jsp B=

index.jsp - Untitled = - | BooY - | standard -

Select program to start

.....................................................................

Design | Source | Preview |

Make sure that you are on the Design page in Page Designer.

Click the Design tab.

Lesson checkpoint

You learned the following:

* How to open the application start page in Page Designer

Working with page properties

Next you work with page properties to move the links down on the page and change the title of the

window to Order Entry.

To work with page properties:

1.

Click before the Select program to start title.

2. Press the Enter key a number of times.

PageBuilder .jsp @ *index.jsp X - =
index.jsp - Untitled * - = | P = Standard -
d

Select program to start
. e

-
Design | Source | Preview |
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3. Right-click the background of the index.jsp page in Page Designer.
4. Click Page Properties on the pop-up menu.

PageBuilder.jsp = O
index.jsp - Untitled * = = | [0 | Standard =
Y
o
of cuk
By
At
| = Paste
¥ Delete
Sele
Save
J Inserk L4
J5p 3
Chrl+Cy
Skyle g 4
Embedded Document 4
Switch Active Document. ..
I N
Desion [EoEl e =) Propetties Ckrl+-Al+Enter
e e L s, HATS Tanle »

The Page Properties dialog opens.
ﬁ) Page Properties

Page Infarmation | Meta Info | J5P Tags |

Page title: | Crder Enkry

Base LIRL: I

Default target: I j

Encoding: 150 10646 Unicode(UTF-S) j

oK I Cancel

5. In the Page title field, type Order Entry.
6. Click OK on the Page Properties dialog.

When this page is shown in a browser, the Window title bar of the browser will now display Order
Entry.

You have changed the window title to Order Entry.
Lesson checkpoint

You learned the following:
* How to change the window title to Order Entry
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Linking a cascading style sheet to a Web page

Now you will add a style to the Web page. You can use a style that is used in your company or you can
use one of the sample style sheets that are provided in the product.

Next you open the Gallery view in the workbench.

To link a style sheet:

[&] PageBuilder.jsp (@ *index.jsp &4 =
index.jsp - Order Entry * = = | E = Standard =
]

zzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzz

Design] Source | Preview | ’(
W\Stvles | Colo}é | Lirks | SErVErs | ‘Web Settings
Skyle Sheet Files (*.css) /

1. Click the Gallery tab, if the Gallery view isn’t already displayed in the left of the workbench.

Image
il Multimedia

Q, Page Template

‘WwebFacing Styles| - = |

Style Sheet

2. Click the Style Sheet icon, to select it.

3. Click the Thumbnails tab on the right bottom pane in the workbench.

You should see thumbnail icons of all the styles available.

4. In the thumbnail view, scroll down to the bottom, until you see style sheet waves001.css in the list, or

select a style sheet that you like best.

5. Click the thumbnail picture of waves001.css with the left mouse button.

6. Hold the left mouse button down and drag the cursor to the Page Designer window.

Web-enable a 5250 application using the IBM WebFacing Tool

93



L
7. The cursor will change from this shape N , to this shape . When the latter cursor shape
appears in the Page Designer window, release the left mouse button.
After a short while the Style sheet properties will be applied and the colors in the page will change to
the style sheet definitions.

| f2] PageBuilder. jsp S| gradient.css *index.jsp X =
index.jsp - Order Entry * - T | BODY - Standard -
~

..............................................................................

Design | Source | Preview |

You have added a style to the Order Entry Web page.
Lesson checkpoint

You learned the following:
* How to add a style to your Order Entry Web page

Adding a heading 1 tag to the page
Now you want to insert a heading below the logo.

To add a heading 1 tag:
1. Position the cursor just below the first BR tag.

=

f] PageBuilder.jsp *index.jsp X9

index.jsp - Order Entry * = = | BODY - | Standard -

o

Select program to start

2. Click Insert from the workbench menu.
3. Click Paragraph > Heading 1 on the pop-up menu.
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o) WebFacing - index.jsp - Websphere Development Studio Client

Advanced Edition for iSerie

File Edit Display | Insert 15F Format Table Frame Page Tools

Mavigate Search Project |

[wit = | 7 Insett Link.,.. Chrl+Q |
JINH &?Anchor... - | | ‘3.}:, . c
Image File El o .
15 O e i co
J 5| | WA List 3
(B WebFacing Proj ~ Harizontal Rule Heading 2 rH2
B Heading 3 Chrl+3
['a L Can Line Break... CErl+Enter Heading 4 Cerl+4
Special Characters. .. Heading 5 Ctrl+5
Mor-breaking Space Ctrl+Shift+Space Heading & Ctrl+6
itk Address
[ = Bllee ' Block CQuokation
-2 LM H
I § [ Insert Table... 4T Freformatted
A line appears that allows you to enter text.
4. Enter your company name Order Entry Application.
PageEuilder.jsp = [
index.jsp - Order Entry * v x | hl = | Standard -

IBM Order Entry
Application|

Y

Select program to start

=

Design | Source | Prewview |

Now you want to use one of the sample pictures included with the product and place this picture on

the page.
You have inserted a heading.
Lesson checkpoint

You learned the following:
* How to insert a heading

Adding a picture to the page
Next you want to add a picture to the Order Entry

To add a picture to the page:

Web page.
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[&] PageBuilder.jsp ( *index.jsp &4 = [

index.jsp - Order Entry * = = | 0= Standard -

-

IBM Order Entry
Application

zzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzz

EEERY

= 5
PRREEENP NN RY SRR EP RN AR, YO NRR IR PP NP EEES P RE RN ERPY PR RE PRI P RN AP EP PN RPN EEE PR R R

Seled program to start

E

E;esign Source | Preview | \
| \D&QSettings |

Image Files (*.qif,*.jpg,*.png,* .brmp, * wmf, *. emf,* kf, * F|:-§\ ped, . mif, *,dcm, * . wbn

i lhe s

oot gif a0zil.gif 003l gif 0041 gif 0050051, Image Size

5 Thumbnails 53 Styles | Calars

1. Move the cursor to below the heading

PageBuilder.jsp = =
indes, jsp - Order Entry ¥ = = | DT | Standard -

-

IBM Order Entry
Application

In the workbench in the Navigator view, select the Gallery tab.

Expand the Image folder.
Select the Illustration folder.

In the Thumbnails view on the right bottom pane of the workbench, select one of the sample
illustrations, for example, use file 005il.gif.

A A

Note: The sample illustrations change between releaseses so 005il.gif might not be available in your
environment.

6. Drag a picture onto the Design page below the heading.
The Design page now contains a picture.
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[&] PageBuilder.jsp 5| gradient.css

index.jsp - Order Enkry * =

]

IBM Order Entry
Application

=

Design] Source | Previsw |

You are almost done. Next you add moving text to the page.

You have added a picture to the Order Entry Web page.

Lesson checkpoint

You learned the following:

* How to add a picture to the Order Entry Web page

Adding moving text to the page

Now you add moving text to the page.

To add moving text:

1. Position the cursor in the Design page underneath the picture.

2. Click Insert from the workbench menu.
3. Click Paragraph > Heading 3 on the pop-up menu.

[l PageBuilder.jsp S| gradient.css @ *index.jsp X

index.jsp - Order Entry * - &~ | ha - | Standard ~

IBM Order Entry
Application

oal t t t t vI
Design | Source | Preview

=
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4.

5.
6.

10.
11.

98

Leave the cursor positioned inside the heading 3 frame.

3] WebFacing - index.jsp - Websphere Development Studio Client Advanced Edition for iSerig
File Edit Display | Insert 3P Format Table Frame Page Tools Mavigate Search  Project

J = | 2 Tnsert Link... CHl+0 J
Jl,n,ria| &7 anchar... Lo | | - 0f -
Image File Lo
[#-0-Q ~ifia e

Paragraph 3
=
J P | ol Lisk 3

wWebFacin,,, & — Horizontal Rule
7'&_ Scripk

= I wiflabso: 2

- = L Cor Line Ereak... Ctrl+Enter
o DDS Special Characters. ..

@s Mon-breaking Space Chrl+Shift+Space # r E nt ry

Background Image File *
Background Music r

[ Insert Table. .. Chrl+T Keyword. ..
index.] BT Insert Free Layout Table [ Date and Time...
¢l logon.| R Insert Text Cel Java Applet...
== Plug-ins. ..
- L1 Layaut Box. object...
_I— Style Container (DIY) Inin=Fhorme
SPAN with Styvle. .. m
SPAN
Comments. ..
Form and Input Fields SR St

a7
Click Insert from the workbench menu.

Click Others > Marquee on the pop-up menu.
The Insert Marquee dialog opens.

Texk:

| Please click button to start application

— Behawvior —Repetition

Movement: ISIide j Repetition: IFinite 'I
Direction: IRight j Count: |1

r Display speed Size
Delay time: I wifidth: I Ipixels j
Scroll amount: I Height: | Ipixe|5 j

[ Wse true speed

r Color

Background color: |:|| j il

414 I Cancel |

Enter into the Text field, Please click button to start application.

Under Behavior, select Slide in the Movement list.
Under Behavior, select Right in the Direction list.
Under Repetition, select Finite in the Repetition list.
Under Repetition, type 1 in the Count field.
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The two last selections just avoid the text sliding in forever and not standing still. If you want more
movement on the page you can change these settings.

12. Select Lime in the Background color list. Click OK on the Color palette.
13. Click OK on the Insert Marquee dialog.
The Design page should look like this.

PageBuilder.jsp

S| gradiert.css *index.jsp X

indes, jsp - Order Entry ¥ = = | b= Standard -

IBM Order Entry
Application

-

DesignJ Source | Preview |

Next you save some space by removing some of the line break tags.
14. Position the cursor just after "Please select link to start application”.
15. Press the Delete key until the SELECT PROGRAM TO START title appears on your page.

[5] PageBuilder.jsp :Si] gradient.css M findesx.jsp. X

index. jsp - Order Entry * = - | BODY - | Standard =

IBM Order Entry
Application

-

i'E'i;l""""""""""""'""""""""""""""""""'! LI
Design Source|Preview|

Next you look at the page, as it would appear in a browser.
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16. Click the Preview tab at the bottom of the Design page.
You will notice that your heading 3 text is sliding in.

[ PageBuilder.jsp S| gradient.css *inde:, jsp

index.jsp - Order Entry *

[ “J'l:’":’

IBM Order Entry
Application

anl LI

Désign | Source [Preview]

You have added a marquee to the Order Entry Web page.
Lesson checkpoint

You learned the following:
* How to add moving text to the Order Entry Web page

Changing the text color

You notice that the text color and the background are not easy to distinguish from each other. One way of
changing this, is to apply another color to a certain area of the text. To do that you return to the Design

page.

To change the text color:
1. Click the Design tab.
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[&] PageBuilder.jsp 5| gradient.css (@ *index.jsp &2 T =

index.jsp - Order Entry * = x | Standard =

[EIY] Order Entry
Application

-

B #foooo - 2 [[TextColer - |

Set as Table Background Color »
ground of Layaut Box

HEE

Set as Background Calor =
1 I

rrrrrrrrrrrrrrRLRRLRRRRRLL
ENEEENSESEEESENEEEEEEEEEEEEEEE

2. Select the company text (IBM) you want to change color on, by selecting the text area with the mouse

Cursor.
Under the Design page, select the Colors tab.
In the Colors view, select a color with your mouse cursor.

Click the down arrow next to the Text Color from the Colors view.

o o A~ W

Click Set as Text Color on the pop-up menu.

You are done; now the selected text will be displayed with the color you selected for it.

You have changed the color of the window title.
Lesson checkpoint

You learned the following:

* How to change the text color of the Window title and background of the Order Entry Web page
Deleting default text from the page

Now you want to remove the default text that was added by the WebFacing Tool.

To delete default text from the page:
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] PageBuilder.jsp SJ gradient.css ,ﬁ *index.jsp X

index.jsp - Order Enkry * ¢ = | Standard -

IBM Order Entry
Application

-

Design | Source | Preview |

1. Select the text.
2. Press the Delete key.
3. Select the Preview tab to view your completed page.

PageBuilder  jsp m gradient.css @, *index.jsp X

index. jsp - Order Entry *

e, Dl

IBM Order Entry
Application

Design|50urce Preview
4. Close the file index.jsp.

5. Click Yes to save the changes.

Page Designer is closed.
6. In the Navigator view or WebFacing Projects view, right-click index.jsp.
7. Click Run As > Run on Server on the pop-up menu.

Note: If you did not select the Set server as the project default (do not ask again) check box on the
Run on Server dialog when you selected the server in [“Showing the index.jsp page” on page 32
ensure that you select the same server on the dialog now. For example, if you had previously selected
WebSphere V6.1 Server, ensure that you select that server now.

Your new designed index.jsp page opens and you can run your application.

102  Web-enable a 5250 application using the IBM WebFacing Tool



= Q§° |http:,I',I'Incalhnst:QDSDwaIabxxiindex.jsp j =

IBM Order Entry B
Application

You have removed the default text added by the WebFacing Tool.
Lesson checkpoint

You learned the following:
* How to remove the default text added by the WebFacing Tool

Module summary

In this module you learned how to enhance the look of the index.jsp page using several Web tools.

After creating and testing your completed WebFacing application, you can deploy the WebFacing

application, if you have WebSphere Application Server Express installed on your i5/0S server. If you
want to deploy your WebFacing application, continue to [“Exporting to i5/0S WebSphere Application|
[Server (Optional)” on page 104

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Open the application start page (index.jsp) in Page Designer

¢ Change the window title to Order Entry

* Add a style to the Order Entry Web page

* Insert a heading

* Add a picture to the Order Entry Web page

* Add a marquee to the Order Entry Web page

* Change the color of the window title

* Remove default text added by the WebFacing Tool

Assessment

¢ What is Page Designer?

* How do you change the window title?

* How do you add a style?

* How do you insert a heading on the page?
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* How do you add a picture to the page?

* How do you add a marquee to the page?

* How do you change the color of the window title?

* How do you remove the default text added by the WebFacing Tool?

Exporting to i5/0S WebSphere Application Server (Optional)

You have tested the WebFacing application in the WebSphere Application Server Test Environment and
you are ready to move it to your i5/0OS WebSphere Application Server production environment. You are
running WebSphere Application Server on your i5/0S server.

Learning objectives

e Use the RSE to move the EAR file from your local drive to the IFS on the i5/0S server
¢ Export the EAR file

* Start an existing HTTP server console

¢ Install and manage the application

* Run the application on the production server

Time required

This module should take approximately 30 minutes to complete.

Exporting your EAR file

The J2EE standard has the concept of an Enterprise Archive File (EAR). This file is an archive that
contains all information about your Web application. In the workbench, this file is built automatically for
Web projects. Since your WebFacing project is a Web project, the wflabxxEAR file exists already. You only
have to copy it to the application server, point to it, and then install the application.

Note: As indicated in System requirements section in the Introduction, check with your system
administrator to ensure that your user ID has the necessary authority to create and access IFS folders.

To export your EAR file:
1. Return to the workbench.
2. In the WebFacing perspective, in the Navigator view, right-click wflabxxEAR and select Export from
the pop-up menu.
The Select page of the Export wizard opens.
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Select

Export an Enterprise Application project into an EAR File

A

=)

Select an export destination:

I type Filker text

= General

@1 RAR file
(= Java

(= Plug-in Developrment
= Profiling and Logging

= wWeb Services
B [= Other

@ < Back I Mext = I

Fimist

| Cancel |

An EAR file is a compressed Enterprise Application Archive, and it contains all the files needed for

the Web application.
Click Next.
The EAR Export page opens.

EAR Export

Export Enterprise Application project to the local file system,

EAR. application;

Deskination: I i ftempfwflabxxEAR, ear

[ Export source Files

[ owerwrite existing file

< Back

ek = | Finish I

Cancel
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4. In the Destination field, specify where you want to put the EAR file by entering the drive and
directory structure on the local file system. For example, C:/temp/wflabxxEAR.ear.

5. Select the Overwrite existing files without warning check box.
6. Click Finish.

If you see a message asking you to create a directory or delete an existing file, Click OK or Yes and
continue.

Now that you have exported the EAR file to your local hard drive, you need to move it to a location
where your WebSphere Application Server is running. In this tutorial, you use a server on an i5/0S
system so you have to copy the EAR file to the IFS of the i5/0S server. You have two choices: you
can map the IFS as a drive or you can use Remote System Explorer to move the EAR file from your
local drive to the IFS.

7. Open the Remote System Explorer. Look for the RSE icon in the taskbar of the workbench and click
it.

8. In the Remote System Explorer perspective, locate the directory where you placed the EAR file. In
the Remote Systems view, expand Local then Local Files and then Drives.

9. Right-click the EAR file and click Copy on the pop-up menu.
10. Expand IFS Files in the Remote Systems view for your i5/0S connection.

11. Right-click the QIBM\UserData\WebSphere\AppServer\V61\Base\profiles\default\installableApps
and click Paste on the pop-up menu.

This is the default directory for installable applications for WebSphere Application Server.

.!” Remote Systems X Team| = = PageBuil
4 & | i Bs Y [
-0 Motessol |

[:I Program Files I B M

[:I Programi

-0 sdwark,

[:I shared

[:I swd

E|Eb Temp

L0 com.ibr.etools.ise
? CustDekSreEAR. &
test.c

/ test,chlle -
AR 00
/ tesk,pf

/ test rpgle

F-[0 test1 G0 To 3
B0 testz
E-C0 Tival
[—~_-| updater Qpen With 4
D WDSC ¥ Refrash
-0 wFDEMO

-0 WINDOW [ Rename.,
e .\!\UTIOEXE )

s Mave... k

Qpen

4]

You have exported the EAR file.
Lesson checkpoint

You learned the following:
* About EAR files
* How to export the EAR file
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Installing the application

At this point, you already need to have set up and started the WebSphere Application Server and an
associated HTTP server on your i5/OS server. You also need to find the port number of the HTTP servers

Administrative Console (referred to as port#a) and the port number to run your application (referred to

as port#b) The second one is the port number of your HTTP server that is set up to work with your
application server.

To install the application:

1.

Open any Web browser and type: http://servername:port#a/ in the Address field.

Tip: The default administrative port number for the HTTP server is 2001.
The Login dialog appears.

Type your i5/0S user ID in the user ID field.

Type your i5/0S password in the password field.

Click OK.

The browser opens.

i5/0S Tasks B

(C) IEM Corporation 2000 TORABZEE TOROLAE IBM.COM

/ IBM Web Administration for i5/08
» Configure HTTF servers, application servers and deploy applications

5 @ iSeries Navigator TRL Advisor
T Leatn how to add 15/03 administration tasks into your web applications
i 4
ﬂi | Digital Certificate Manager
bl Create, distribute, and manage Digital Certificates
IBM Directory Server for i5/08
f & drrandster the IBM Directory Setver

IBM IPP Server for i5/08
Configure the IEM IPP Berver

::" J Cryptographic Coprocessor
o l Configure the cryptographic coprocessor

r i5/08 Web-Based Help Server
A & dmrandster the Web-based help setver

Click IBM Web Administration for i5/0S from the i5/0S Tasks menu.
The Administration pages for the HTTP and application servers display.
Select the Manage tab then the Application Servers tab.

The Manage WebSphere Application Server page displays.
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ﬁ'HTTP Server Administration on TORAS33E - Windows Internet Explorer
@ ol v || T O1jHT TR Admin =] #2] % ILive Sea
S0 G0 @HTTP Server Administration on TORASTIE ﬁ -8B

IBM Web Administration for i5/0S

WETE M Advanced | Related Links

All Servers | HTTF Servers  Application Servers  ASF Tomcat Servers
@ Running Server: |WFWA861 SVRAVPWASETEVR - vB.1 Base j

w Commaon Tasks and Wizards 21 WEWASETSYRAMEYWASET SVE
J Create HTTF Server

J Create Application Server - -
Mool Chaalin e Manage WebSphere Application Serve

J Create webSphere Portal FProfite: WRFWASHTSVR  Server WRWASHTSVR
J Create IBM Warkplace _
Product install path: \QIBMProdData/WebSphere/AppS

 WAS VWizards

J Create ¥irtual Host . .
1 Install New Application WehSphere application serer created by the WebFacing t

J Create JDBC Provider - - .
J Create Data Source i f ¥ ~ ¥

J Deploy |[BM Telephone Directon i | L
_ Deplay 1M Survey Creator Create ﬂdl;l-lltnlgtnal Virtual Install New Application

The default virtual host After creating the server and

"Adefanlt hact" woae craatad wirkiial lhact uan faln metall

+* Server Properties
7. Select your WebSphere Application Server server instance from the Server list.

Make sure the server instance is running by clicking the Run button to the left of the server instance.
8. Click Install New Application in the right pane.

The Install New Application page displays.

WEWASET SVRMPWASETSVR = Install Mew Application

Install New Application
Specify Application Location

Welcome to the Install Mew Application wizard. This wizard will install an application into this
WebSphere Application Server. The application must already exist on the I5/05 serverin an
intearated file system directary.

o Application is contained in an EAR file

Integrated file systern path of EAR file: JQIEM/UserData’WebSphere/AppServerB1/Base/r

Mote: The file must already be on the i5/0S server.

 Application is contained in 2 WAR file

4| | l

Back || Next Cancel

=

9. Click the Application is contained in an EAR file radio button.
10. Specify the location of your EAR file; (the file that you exported in the previous step).
You can use the Browse push button to locate the file.
11. Click Next.
A page appears with options for application installation.
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12.
13.

14.

15.
16.
17.

WEWASET SYRANFWASETSVE = Install Mew Application

Install New Application
Frowide Options to Perform the Install

Specify application deployment options

Application name:; |w1'|ah}{}{|
Directary application installed to; iQIBMiUserDatafiehSpherefppServer®/'B1/Baseiprofilesis
¥ Pre-cormpile JSPs

Mote: Pre-compiling JSFs can have significant performance impacts. When enabled, the J5Ps
compiled atinstallation time, causing the application install to take longer. When disahled, the
firsttime they are accessed, causing the first use ofthe application to take longer.

4| 2l

Back || Next Cancel

[
In the Application name field, type wflabxx.

You can select the Pre-compile JSPs check box to speed up the process of showing the page the first

time. (JSPs are compiled into Servlets when first generated.)
Click Next.
The Map Virtual Hosts Page appears.

WIFWASET SYEMIFWASETSYE = Install Mew Application

Install New Application
Map Virtwal Hosts for Web Moduies

Specify the vifual hostyou want to associate with the Weh modules contained in this
application. Web modules can be installed on the same vitual host or dispersed among
several witual hosts.

Map ¥eb modules to vitual hosts:
Wehbh module Virtual host Web server
wifla b

default hostiid W WEWESRYERT

Back | Mext Cancel

=l
Select the virtual host to be associated with the Web module.

Select a virtual host of your choice, or leave the default host selected.
Click Next.

The application summary page displays.
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WEWWASET SYEMIFWWASET SYE = Install Mew Application

Install New Application
Surnrany

When you click Finish the installation will he started for the following application.

Integrated file system path of EAR file: /QIBM/UserDataiehSphereidnpServerfvE1/Basefprofiles,

Application name: wifla ko
Directory application installed to: Ml serDatafiebSpherefAppSenerVE1/IBase/profiles.
Pre-compile JSPs: Enabled

Map Web modules to virtual Weh module | Virtual host Weh server
hosts: wfl 3 bns default_host v WEWEBSRYER1

4| | |

Back Finish Cancel

=1
18. Click Finish.
After the successful installation you see a page where you can manage the installed applications.

@ Running | (][] server [WFWASETSVRIWFWASETSVR - VB.1 Base =l

* Commaon Tasks and Wizards 21 WEWASETSYREMIPWASE] SVE
J Create HTTF Server

J Create Application Server - -
5 Miarale Original i Anachs Manage WebSphere Application Sen

J Create WebSphere Portal FProfile: WRWASBTSVR  Sener WRFWASGTSVR
J Create 1IBM Waorkplace .
Froduct install path: [QIBM/ProdDataWebSphereiip,

- WAS Wizards
2 Create Virtual Host
J Install Mew Application
2 Create JOBC Provider S _
2 Create Data Source ] ﬁ ¥ s 4§
J Deploy IBM Telephone Directon
J Deploy IBM Survey Craatar

WiebSphere application server created by the YwebFacir

Create Additional Virtual Install New Applicatio
Host

The default vitual host After creating the server a

"default_host” was created  wirtual host you can instal

far this application server. your applications.

w Sener Properties
B Properties
[ Server Tracing

B Server Ports However, you can specify
& iew HTTP Sarvers additional virtual hosts for
mare contral over what
- Applications LRI's can run which
B Manage Installed Applications applications.
w Resource Configuration
B Manage Virtual Hosts
B Manage JDBC Providers i Manage Virtual Manage Installed
B Manage Data Sources Hosts Applications
. @ default_host B whabix
* Problem Determination -
B Yiew Logs «| | @ admin_host @ E013-ENU-Wehb-
i | 2] 051122

19. Click Manage Installed Applications under Applications.
A page with the installed applications displays.
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Manage Installed Applications

Data current as of Feb 8, 2007 10:23:12 AM.

Installed applications:

o)

S ® & & & 9

-

Install

Close

Application name
wiflabi

WE013-EMU-Web-061122
WE013-CHT-Yeb-051122
DefaultApplication
hats1109_wthats1109
query

wtApp

izclite

Start Froperties

Status
[C] Stopped
@ Funning
@ Funning
@ Funning
@ Funning
@ Funning
@ Funning
@ Funning

Uninstall

Enablement

Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled

Lpdate

Refresh

20. Click the wflabxx radio button in the list of installed applications.

21. If the wflabxx application is disabled, click the Properties push button to enable the application.

General

Lacation:

Application Properties

Application name; wilakng
Application enablerment. [{SREERE -

BMUserDatadebSphereffppServerE1/BaselprofilesAWRYWASE1 SWR

Virtual Host Mapped to Web Modules

WEWASET SVRANVEYWASET SWRE = Manade Installed Applications = Application Properies

22. Select Enabled from the Application enablement list.
23. Click OK.
Next you start the application with wflabxx in the enabled state.

0]

@ ® @ & & &

I

In=tall

Close

Installed applications:

Application name
wilabix

WB013-ENU-YYeb-061122
WB013-CHT-Web-061122
DefaultApplication
hats1109_withats1109
fquery

ivtApp

isclite

FProperties

Manage Installed Applications

Data currentas of Feh 9, 2007 10:24:37 A,

Status
(] Stopped
@ Running
@ Running
@ Running
@ Running
@ Running
@ Running
@ Running

ninstall

24. Click the wflabxx radio button.

Enablement

Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled

Update

Refrash
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25. Click Start.
If the Start button is not enabled, start the server first.

Now you are ready to test your WebFacing application.
You have started the existing HTTP server, installed and managed the application.
Lesson checkpoint

You learned the following:

* How to start the existing HTTP server, install and manage the application

Testing the deployed WebFacing application

Next you test the deployed WebFacing application.
To test the Web application:
Open the Internet Explorer and type http://servername:port#b/wflabxx in the Address field.

Tip: This is the HTTP port name, most likely 80, not the application bootstrap port. You can find the port
number of the HTTP server by clicking Server Ports under Server Properties.

Your application index.jsp page should open. If it does not, double-check the URL and the port number.
Also try restarting the HTTP server and the application server. Refer to the Administrative Console Web
site if you are having problems starting and running the HTTP server or the WebSphere Application
Server. If you still encounter problems, there are troubleshooting guides, FAQs, and newsgroups on the
Web where you can find an explanation of your situation with more detailed information.

You have run the application.
Lesson checkpoint

You learned the following:
* How to test the deployed WebFacing application

Module summary

In this module you learned how to deploy a WebFacing application to a production server.

The IBM WebFacing Tool in Host Access Transformation Services (HATS) for System i Toolkit allows you
to mix a WebFacing application with a non-WebFacing application.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Map a network drive

* Open the Export wizard

* Export the EAR file

* Start an existing HTTP server console

¢ Install and manage the application

* Run the application on the production server
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Assessment

* How do you map a Network drive?

* How do you export an EAR file?

¢ What is an EAR file?

* How do you start an existing HTTP server?

* How do you install the EAR application?

* How do you test the installed application on the production server?

Mixing a WebFacing and non-WebFacing application

If a WebFacing application encounters certain system screens or non-WebFacing 5250 applications, then
the on-the-fly transformation capabilities, included with Host Access Transformation Services (HATS)
today, are leveraged to deliver the screens in a browser using the same style as the WebFacing
application.

This module teaches you how to mix a WebFacing and non-WebFacing application.

Learning objectives

* Add a CL command to call a 5250 application
¢ Launch the mixed application

* Test the application

Time required

This module should take approximately 15 minutes to complete.

Adding another CL command to launch another application

You will now provide the information that will allow the WebFacing Web Project wizard to add another
Launch button on the initial index.jsp page to start the Customer Inquiry application, another 5250
application that will take the user interface to this application and transform it on-the-fly to an HTML
interface.

The WebFacing run time needs to know the invocation command for this additional application in order
to send this invocation command to the i5/0S server to start your application from the browser. The
page in the WebFacing Web Project wizard will allow you to add the necessary information CL command
and Sign on information.

To specify the CL commands:

1. Right-click the CL commands under the wflabxx WebFacing project and click Add on the pop-up
menu.
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2. In the CL Command field, type go celdial and in theCommand Labelfield, type Customer Inquiry
Application.

Tip: If you don’t type anything into the Command Label field, the CL command input will be copied
into this field.

3. Leave the default value INV2 in the Invocation name field.

4. Click the Specify i5/0S signon values radio button and enter the user ID and password that you
have used previously for the Order Entry Application.

5. Click Add on the right side of the page.

Tip: Make sure the text and command you typed into the fields are actually shown in the CL
Command table at the bottom of the page.
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® add CL wizard x|

Specify CL Commands

Enter the CL commands that are used in your application, the command labels vou want to use, and the signon
preference for the generated hypertesxt links,

Project name:; I wiflabio

WebFacing generates hypertext links that vou can use to launch your application From the Web, In order ko do this, it needs to
know the kext that will be shown For each link and the CL command that each link will invoke. On this page vou can define
multiple links, in case several CL commands are used tao launch wvour application.

If wour program requires parameters, you can enter them as variables in the CL command. For example: to invoke program
MYPGM with & part number parameter, wou would enter CALL MYPGM PARM(R:part) as the CL command. The variable "&part”
will be replaced when wou dlick on the invocation link. For details, refer to the generated index.jsp file. The invocation name is

used ko uniquely identify each hyperlink in the index. jsp file.

CL command: I go celdial

Command label: | Customet Inguiry Application

Invocation name IIN\I‘Z

" Prompt for signon

% Sperify i5/05 signon values
UserID | wlabee

Password I i Confirm password

Add

i

[adifa

I sokktttsk

L Commanid | Carnmand Label | Invocation nane | User ID
Delete |
Mowe U |
[Morve Down |
4| | i
(?)

Einish I

Cancel |

6. Click Finish at the bottom of the wizard page.

The CL command to call the additional Customer Inquiry application is added.

You have added another CL command to launch a 5250 application.

Lesson checkpoint

You learned the following:

* How to add another CL command to launch a 5

250 application
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Testing the non-WebFacing application

Recall that the IBM WebFacing Tool creates a Web interface to a 5250 application based on the DDS
source code. The Web interface is created in a development time conversion. Starting in Development
Studio Client Version 6.0.1 and with i5/0S® V5R4, the IBM WebFacing Tool can generate on-the-fly
transformations.

You must purchase the IBM® Rational® Host Access Transformation Services (HATS) license to enable
your WebFacing applications for use in a production environment. Without a valid license, you are
limited to two concurrent trial WebFacing connections.

To run the non-WebFacing application for testing purposes:
1. Right-click index.jsp in the WebFacing Projects view.

2. Click Run As > Run on Server on the pop-up menu.

Note: If you did not select the Set server as the project default (do not ask again) check box on the
Run on Server dialog when you selected the server in |[“Showing the index.jsp page” on page 32
ensure that you select the same server on the dialog now. For example, if you had previously selected
WebSphere V6.1 Server, ensure that you select that server now.

3. In the browser pane, click the Launch link for the Customer Inquiry Application.

PageBuilder.jsp | S| gradient.css m

= Qéh |http:,l'll'lncalhnst:QDSDIWFIabxx,I'index.jsp j B

IBM Order Entry 5
Application

After a few moments the first application page opens in the browser.
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B Enter

mF]

mFE2

mF3

mF4

Ll

Ll =]

mF7

Ll

BFg

mF10 [

mF11

mF12

mF13

mF14

BF15

BF16

CELDIAL Cellial Commi
Select one of the following:

1. Customer incuiry
2. Work with inwventory

Gelection or command

===

Fi=Exit Fd=Prompt
Fli=Information Assistant

Fo=Petriewve
Flo=3vstem main

mC17

4. Check the Console view for a message that indicates that a HATS license is needed to run this
application with more than two connections.

Thumbnails|5tyles|C-:Ic-rs|Links|5ervers B Consols ‘eb Settin-;s| =0
WebSphere Application Server ve.1 [WebSphere w61 Server] WebSphere Applical 3& | B "E e El rej o
020 Systemiut O Valid license not found. You have two trial connections”:J
020 ZervletlWUrappe I SEVEDZ2421: [wflsbxxEALR] [/uflabxx] [fwuehfacing/styles/ic
0z0 SerwvletWrappe I SEVEO24:2T: [wflshxxELR] [/wflabxx] [/webfacing/jsp/com:
020 ServletlWrappe I SEVEDZ2421: [wflabhxxELR] [/wflabxx] [/fwebfacing/jsp/DD3r
020 ServletWrappe I SEVEDZ242T: [wflsbxxELR] [/uflabxx] [/fwehfacing/jsps/DDSE
020 ZervletlWrappe I SEVED242T1: [wflsbxxELR] [/uflabxx] [fwebhfacing/jsp/ conmm
0z0 Servletlrappe I SEVEO242T: [wflshxxEALR] [/fwflabxx] [/uebfacing/jsps/DDSr
0z0 ServletWrappe I SEVEO242T: [wflshxxELR] [/wflabxx] [/webfacing/jsps/DDSr
020 PropertvyMessa I org.apache.comnons. logging. impl.Jdkld4Logger info Initiali
020 ServletWrappe I SEVEDZ242T: [wflsbxxELR] [/uflabxx] [/fwuehfacing/styles/ic
01d ZervletlWrappe I SEVEDZ2421: [wflsbxxEALR] [/uflabxx] [fwebhfacing/jsp/ comm
01ld PropertyMessa I org.apache.comnons. logging. impl.Jdkl4Logger info Initiali
020 ServletWrappe I SEVEDZ2421: [wflahxxELR] [/wflabxx] [/webfacing/jsp/conm
020 Systemiut o]
Z006. A4ll right=s reserved.

5. Type 2 in the command field to open the Work with Inventory window. Press Enter.
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T/02/28 Cellial - Work with Inwentor:

Type option, press Enter.

Z2=Change d=Delete E=Display G=Print
Opt Manber Description

ID aoood Meszzage Hasze

D aoo4a Battery Charger 12V

D nonez Base Unit - Auto

D ooo7a Module Puller-deluxe

D 0on7l Carry Case - Deluxe

D aoo7z Carry Casze - Nylon

D ooovd ddapter - Lz0V

D 000as Prezsentation Hox

D oons’y duto Antenna - mag

D oonol Antenna -replaceable

D oooss Porta-Caze

D aooss LUto Antenna - perm

D aoloo Fechargeahle Battery

D oozs4 pullar 2
Fi=Exit Fe=4dd a part FlO=3pool files

mFoz

6. Play in the application as much as you like trying different function keys and options. When you are
finished, exit the application.

You have seen the results of calling a non-WebFacing application on-the-fly and seeing the results in the
browser.

Lesson checkpoint

You learned the following:

* How to call a non-WebFacing application on-the-fly and see the results in the browser.
Module summary

In this module, you learned how to use WebFacing Tool extensions to mix a WebFacing application with
a non-WebFacing application. To learn more about mixing WebFacing applications with non-WebFacing
applications, see the Create a combined WebFacing and HATS application tutorial.

Lessons learned

By completing this module, you learned about the following concepts and tasks:
* Add a CL command to call a 5250 application

* Launch the mixed application

* Play in the application
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Assessment
* What is a HATS license?
* How do you add a CL command to call a 5250 application?

* How do you launch the mixed application?

Summary

This tutorial has taught you how to convert the DDS screens in an existing 5250 order entry application
to a Web browser user interface. While creating a browser user interface, you learned how to use the IBM
WebFacing Tool. You also learned how to customize the output of the conversion process using the IBM
WebFacing Tool, Screen Designer, the LPEX Editor and Page Designer. Next you learned how to run the
WebFacing application in the WebSphere Test Environment that is part of the product. Finally, you
learned how to mix a WebFacing and non-WebFacing application with Dynamic Data Stream
Transformation.

If you have completed all of the modules, you should now be able to:

* Create a WebFacing Web Project

* Convert one or more DDS and UIM files

* Run the application in the WebSphere Test Environment

* Customize the WebFacing application

* Secure your application by forcing authentication before the application is called
* Make the input page of the application more interesting

* Deploy the WebFacing application to a production server (optional)

* Mix a WebFacing and non-WebFacing application

More information

For more information on the product and the IBM WebFacing Tool, see http://ibm.com/software/
awdtools/iseries.
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U.S. Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP
Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A. IBM may not offer the
products, services, or features discussed in this documentation in other countries. Consult your local IBM
representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user’s
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
documentation. The furnishing of this documentation does not give you any license to these patents. You

can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
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North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR CONDITIONS OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

Intellectual Property Dept. for WebSphere Software
IBM Corporation

3600 Steeles Ave. East

Markham, Ontario

Canada L3R 9727

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this documentation and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
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cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

Copyright license

This information contains sample application programs in source language, which illustrates
programming techniques on various operating platforms. You may copy, modify, and distribute these
sample programs in any form without payment to IBM, for the purposes of developing, using, marketing
or distributing application programs conforming to the application programming interface for the
operating platform for which the sample programs are written. These examples have not been thoroughly
tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 1992, 2007. All rights reserved

Trademarks and service marks

The following terms are trademarks or registered trademarks of International Business Machines
Corporation in the United States, other countries, or both.

+ IBM

» i5/0S

* iSeries

* Rational

* Systemi
* WebSphere

Intel® and Pentium® are trademarks of Intel Corporation in the United States, other countries, or both.

Microsoft, Windows, Windows NT® and the Windows logo are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

UNIX? is a registered trademark of The Open Group in the United States and other countries.
Linux® is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of others.
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